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Product description

The HID Real-Time PCR Analysis Software is designed to assist human identification laboratories that
perform DNA quantitation by simplifying assay setup, data review, and dilution and reaction setup for
downstream STR analysis. For example, the software automatically selects the appropriate Quantifiler™
kit target, reporter, quencher, and thermal profile.

After a run, the software provides an analysis of each well, then allows you to export the following data:
* All results
® STR kit setup instructions
* Sample dilutions calculations

New features in v1.4

HID Real-Time PCR Analysis Software v1.4 includes all v1.3 functionality and the following new
features:

¢ Compatible with the QuantStudio™ 5 Real-Time PCR System with firmware v1.5.1 or later

® Supports the Java™ software upgrade from v6 to v8

Note: We do not recommend using HID Real-Time PCR Analysis Software v1.4 with the 7500 Real-
Time PCR System for Human Identification.

HID Real-Time PCR Analysis Software User Guide 7
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Compatible systems

The HID Real-Time PCR Analysis Software is compatible with the following systems:

Recommended

with firmware v1.5.1 or later

System HID Real-Time PCR Analysis
Software version
7500 Real-Time PCR System for Human Identification v1.3
QuantStudio™ 5 Real-Time PCR System (with 0.2-mL 96-Well Sample Block) Vi3
with firmware v1.3.x )
QuantStudio™ 5 Real-Time PCR System (with 0.2-mL 96-Well Sample Block) vid

Note: To check the firmware version for your QuantStudio™ 5 Real-Time PCR System, see “Computer

and instrument requirements” on page 10.

Compatible HID kits

You can use the HID Real-Time PCR Analysis Software with the following HID Kits:

¢ Quantifiler™ HP DNA Quantification Kit

* Quantifiler™ Trio DNA Quantification Kit

* Quantifiler™ Human DNA Quantification Kit
* Quantifiler™ Duo DNA Quantification Kit

Custom experiment option

IMPORTANT! The custom assay option is supported only for the 7500 system.

You can also use the HID Real-Time PCR Analysis Software for more complex experiments by selecting
the Custom Assay option on the Home screen. For instructions, see the user documentation for your

instrument.

HID Real-Time PCR Analysis Software User Guide
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HID Real-Time PCR Analysis Software workflow

HID Real-Time PCR Analysis Software workflow

Set up a Quantifiler™ kit plate, then load the plate in the instrument.

Select the experiment and set up a plate:

Start the software.
Start a new experiment and specify experiment properties.
Define samples; assign targets, samples, and standards to wells.

Ao np A

Save the experiment.

Run the plate.

Select analysis settings and thresholds:
® HID settings (includes HID flags)

* Flag settings

Review results:

1. View the analysis summary.
2. View the quantitation results.

Export and print results.

Generate dilution and reactions worksheets for STR setup:

Configure the STR library and default dilution settings.
Add kits to an experiment.

Select the unknown samples for amplification.

(As needed) Edit dilution settings for individual samples.

oM oDN

Export dilution and reaction worksheets.

Perform PCR ampilification

For instructions, see your instrument user guide.

HID Real-Time PCR Analysis Software User Guide 9
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Computer and instrument requirements

Component Requirements

Computer * Processor (minimum: 2.9 GHz):
— (Recommended) Intel™ Core™ i7 Quad Core™ CPU, 2.9 GHz

- Intel™ Core™ i5 Quad Core™ CPU, 2.9 GHz
* 16 GB of RAM!!
* One hard drive with at least 10 GB available
* 20/48X IDE CD-ROM drive
* USBvi.2
* Ethernet network interface adapter (10BASE-T)2I$
* Microsoft™ Windows™ 10 loT Enterprise (LTSC 2019 or 2021)

IMPORTANT! If the computer that performs a run is on a network, avoid excess
network use during the run.

Software * Microsoft™ PowerPoint™ software (for direct export of PowerPoint™ slides)

* Microsoft™ Excel™ software (for direct export of data to spreadsheet)

IMPORTANT! Do not run antivirus applications while the HID Real-Time PCR
Analysis Software is running. Antivirus applications may interfere with data
collection from the instrument.

10 HID Real-Time PCR Analysis Software User Guide
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Computer and instrument requirements

(continued)
Component Requirements
Monitor e 1280 x 1024 pixel resolution for full screen displayl]

* 16-inch
* True Color (32 bit)
e UL listed

7500 Real-Time PCR
Instrument

Instrument firmware vG2.10 (installed on all instruments purchased after 2008)
To check the firmware version of your instrument, go to the following location:
<drive>:/Applied Biosystems/7500 system/firmware

Contact Service if your firmware version is not vG2.10.
| Narme Type
| ] €9254 01 Ver2 1955 S File
| ] VerG210 App.bin BIN File
n ﬁ?&rﬁ;&ﬂ_BaDtApp.bin BIN File

QuantStudio™ 5 Real-
Time PCR System
(with 0.2-mL 96-Well
Sample Block)

Instrument firmware v1.3.x

To check the firmware version of your instrument: From the Home screen, tap @
Settings » About Instrument » About Instrument.

Instrument firmware v1.5.1 or later

To check the firmware version of your instrument: From the Home screen, tap @
Settings » About Instrument » About Instrument.

' The software may experience communication errors if run on computers with less than 1 GB.
[ Required only if you plan to connect the computer to a local area network (LAN).
B If screen resolution is not set to 1280 x 1024, the Analysis Summary screen may not be properly displayed.

7500 Real-Time PCR Systems purchased before February 2008

If your 7500 Real-Time PCR System was purchased before February 2008: Tower and laptop computers
require a memory upgrade before the computers can install the HID Real-Time PCR Analysis Software.
For more information, see the 7500/7500 Fast Real-Time PCR Systems User Bulletin Memory Upgrade
Requirements for 7500 Software v2.0 (Pub. No. 4379705).
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Install the HID Real-Time PCR Analysis Software

Install the HID Real-Time PCR Analysis Software

IMPORTANT! You must have Administrator privileges on the computer to install HID Real-Time PCR

Analysis Software.

Install instructions are available in the Release Notes.

1. Obtain the appropriate upgrade version of the HID Real-Time PCR Analysis Software for your

system.
Recommended HID Real-Time PCR
Instrument . .

Analysis Software upgrade version

7500 Real-Time PCR System for Human Identification v1.3

QuantStudio™ 5 Real-Time PCR System (with 0.2-mL 96-Well Sample Block) Vi3

with firmware v1.3.x '

QuantStudio™ 5 Real-Time PCR System (with 0.2-mL 96-Well Sample Block) vid

with firmware v1.5.1 or later

Note: To check the firmware version for your QuantStudio™ 5 Real-Time PCR System, see
“Computer and instrument requirements” on page 10.

2. Insert the HID Real-Time PCR Analysis Software DVD into a computer.

3. Open the Release Notes, then follow the appropriate install instructions for your system.

Install instructions are provided for the following scenarios:

System Computer Scenario

7500 Real-Time PCR System for Instrument Install the HID Real-Time PCR Analysis Software on an

Human Identification computer instrument computer that is running an earlier version of
the HID software
Install new HID Real-Time PCR Analysis Software on a
new instrument computer

QuantStudio™ 5 Real-Time PCR Instrument Install the HID Real-Time PCR Analysis Software on an

System with firmware v1.3.x computer instrument computer that is running an earlier version of
the HID software
Install new HID Real-Time PCR Analysis Software on a
new instrument computer

QuantStudio™ 5 Real-Time PCR Instrument Install the HID Real-Time PCR Analysis Software on an

System with firmware v1.5.1 or later computer instrument computer that is running an earlier version of

the HID software

Install new HID Real-Time PCR Analysis Software on a
new instrument computer

12
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(continued)

Calibrate the 7500 instrument

System Computer

Scenario

Non-instrument
computer

All systems

Install the HID Real-Time PCR Analysis Software on
a non-instrument computer that is running an earlier
version of the HID software

Install new HID Real-Time PCR Analysis Software on a
non-instrument computer

Calibrate the 7500 instrument

IMPORTANT! For system layout, electrical, power, safety, and other site requirements, see the Applied
Biosystems™ 7500/7500 Fast Site Preparation Guide (Pub. No. 4412843).

If you

Perform

Installed new HID Real-Time PCR Analysis
Software with a new instrument

Perform all calibrations and run the RNase P plate

Upgraded from an earlier version of the
HID Real-Time PCR Analysis Software

After restoring the calibration files from the earlier HID
software version (see the Release Notes), perform a
custom dye calibration to calibrate ABY™, JUN™, and
MUSTANG PURPLE™ (MP) dyes.

Replaced SDS Software v1.2.3

Perform all calibrations and run the RNase P plate

Required materials not supplied

Table 1 7500 Real-Time PCR Instrument—Materials required for calibration

If you Material Cat. No.
Replaced SDS Software v1.2.3 7500 Real-Time PCR Systems Spectral 4349180
Calibration Kit |
TagMan™ RNase P Instrument Verification Plate | 4350584
96-Well Spectral Calibration Plate with ABY™ 4461591
Dye
96-Well Spectral Calibration Plate with JUN™ 4461593
Dye
96-Well Spectral Calibration Plate with 4461599
MUSTANG PURPLE™ Dye
Upgraded from an earlier version of the 96-Well Spectral Calibration Plate with ABY™ 4461591
HID Real-Time PCR Analysis Software Dye
HID Real-Time PCR Analysis Software User Guide 13
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Table 1 7500 Real-Time PCR Instrument— Materials required for calibration (continued)

If you Material Cat. No.
Upgraded from an earlier version of the 96-Well Spectral Calibration Plate with JUN™ 4461593
HID Real-Time PCR Analysis Software Dye
96-Well Spectral Calibration Plate with 4461599
MUSTANG PURPLE™ Dye

Calibration procedures

The following is an outline of the calibration procedures for the 7500 Real-Time PCR Instrument. For
complete instructions, see the 7500/7500 Fast Real-Time PCR Systems System Maintenance Guide
(Pub. No. 4387777).

* Regions of Interest (ROI) calibration
* Background calibration
* Optical calibration

* Dye calibration:
— Perform dye calibration of the ABY™, JUN™, and MUSTANG PURPLE™ (MP) dyes. Follow the
custom dye procedure.

— Perform dye calibration of all system dyes for new instrument installations, or if replacing SDS
Software v1.2.3.

— Use 60°C as the default temperature for all dye calibrations.

* TagMan™ RNase P Instrument Verification Plate run

14 HID Real-Time PCR Analysis Software User Guide
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Calibrate the 7500 instrument | < |
New dye spectra for the 7500 Real-Time PCR Instrument

Figure 1 through Figure 3 show the calibration spectra for ABY™, JUN™, and MUSTANG PURPLE™ (MP)
dyes.
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Figure 1 ABY™ dye spectra
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Figure 2 JUN™ dye spectra
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Figure 3 MUSTANG PURPLE™ (MP) dye spectra
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Calibrate the QuantStudio™ & Instrument

Calibrate the QuantStudio™ 5 Instrument

IMPORTANT! For system layout, electrical, power, safety, and other site requirements, see
the QuantStudio™ 5 Real-Time PCR Instrument Site Preparation Guide (for Human Identification)

(Pub. No. MAN0016701).

The QuantStudio™ 5 Real-Time PCR Instrument is calibrated during manufacturing; however, you must
recalibrate the instrument for the dyes that are used for HID analysis before use. If you installed
HID Real-Time PCR Analysis Software with a new instrument, perform custom dye calibrations for the

ABY™ and JUN™ dyes.

Required materials not supplied

Table 2 QuantStudio™ 5 Real-Time PCR Instrument—Materials required for calibration

Material Cat. no.
96-Well Spectral Calibration Plate with ABY™ Dye 4461591
96-Well Spectral Calibration Plate with JUN™ Dye 4461593
TagMan™ RNase P Instrument Verification Plate, 96-Well 0.2-mL 4432382

Calibration procedures

The following is an outline of the calibration procedures for the QuantStudio™ 5 Real-Time PCR
Instrument. For complete instructions, see the QuantStudio™ 3 and 5 Real-Time PCR Systems
Installation, Use, and Maintenance Guide (Pub. No. MAN0010407).

* Dye calibration:
— Perform dye calibration of the ABY™ and JUN™ dyes. Follow the custom dye procedure.

— Use 60°C as the default temperature for all dye calibrations.

IMPORTANT! You must calibrate the ABY™ dye as ABY-HID and the JUN™ dye as JUN-HID.
Calibrating either dye without the “-HID” suffix (as ABY and JUN) overwrites the existing
calibrations for the factory-calibrated system dyes. Doing so potentially creates confusion if the
instrument is ever calibrated using the QuantStudio™ 3 and 5 Calibration Kit, which does not have

the HID versions of the dyes.

* TagMan™ RNase P Instrument Verification Plate run

HID Real-Time PCR Analysis Software User Guide 17
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New dye spectra for the QuantStudio™ 5 Real-Time PCR Instrument

Figure 4 through Figure 6 show the calibration spectra for ABY™, JUN™, and MUSTANG PURPLE™ (MP)

dyes.
Dye ABY-HID
1.0
u
2
c 08
[N
un
ol
]
F 0.6
[T
=
al
N
= 0.4
E
-
2
02
0.0 A = =

®1-rrod 1-mi 1-rr@ 1 -rrod -rro6i1 - ro@ 22 -rrod2 - rrod2 - rmd 2 - ref3 - reet3- rrod3-reodE- rm @ G- e rroBd rrS-mE S-S -mia

Filter
Figure 4 ABY™ dye spectra
Dye JUN-HID
]
u
£
g 0a
(=]
1]
L
_3 0
[
=
a
o
= 0.4
E
[=]
z 02
0o I i ===

€ 1-rrod 1-rm@ 1-rr@ 1 -reed -rrofi1 - rr8 2- 2 -rrod2 - rrod? -rmd 2 - 3 - ret3- rrodd-reofa- r @ G- et e rrdS- maS-rdd-mi
Filter

Figure 5 JUN™ dye spectra
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Dye MUSTANG PLURPLE
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Figure 6 MUSTANG PURPLE™ (MP) dye spectra
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Modify a default experiment template

You can make changes to the experiment templates provided with the software after making a backup
copy of the original templates.

Save a copy of the original template

Before you modify a template, save a copy of the original template:

1. Navigate to: <drive>:/Applied Biosystems/7500/config/templates
2. Select Edit » Copy to copy the templates folder.
3. Navigate to a safe location on your computer.

4. Select Edit » Paste to insert a copy of the templates folder in the location you selected.

Modify the original template
1. Click the button on the Home screen for the experiment type of interest.

2. Modify the template as needed, including:
* Moving standards and NTCs to different wells
¢ Adding samples and/or extraction blanks
¢ Setting the plate layout
* Setting the display defaults for the amplification plot, plate view, and well table
* Modifying analysis settings (HID, C+, and flags)

3. In the toolbar, click the down arrow next to Save, select Save as, then select the name of the
original template.

20 HID Real-Time PCR Analysis Software User Guide



Chapter 3 Customize the software =08

A
Create an experiment template

Create an experiment template

1. Set up an experiment with the desired settings, including:
* Moving standards and NTCs to different wells
¢ Adding samples and/or extraction blanks
® Setting the plate layout
* Setting the display defaults for the amplification plot, plate view, and well table
* Modifying analysis settings (HID, Cy, and flags)

2. In the toolbar, click the down arrow next to Save, then select Save as Template.

To use your template instead of a default template: At the top of the Home screen, click Open, then
select your template.

Link your template to a Home screen button

You can link your template to any of the Quantifiler™ assay buttons on the Home screen.

The software will automatically use the template as the default experiment when you click the
corresponding button. You will still be able to use a different template by opening a different
experiment.

1. Before linking, save a copy of the original template.
a. Navigate to <drive>:/Applied Biosystems/7500/config/templates

o)

. Select Edit » Copy to copy the templates folder.
c. Navigate to a safe location on your computer.
d. Select Edit » Paste to insert a copy of the templates folder in the location that you selected.

2. Link your template to a button on the Home screen.
a. Open the file that you want to link.

b. In the toolbar, select Save » Save as Template.

c. Navigate to <drive>:/Applied Biosystems/7500/config/templates
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Set display defaults

d. Select the file corresponding to the assay button that you want to replace.

IMPORTANT! Files that contain the “QS5” suffix are templates used by the QuantStudio™

5 Instruments. For example, “QuantifilerTrio.edt” is the template file for the Quantifiler™ Trio
DNA Quantification Kit used by 7500 Instruments; “QuantifilerTrioQS5.edt” is the file used by
QuantStudio™ 5 Instruments.

2 Save As Template @
Savein: | | templates ": |}]|:j||§§3
e 2| QuantifilerDuo.edt |
s B 2] QuantifilerDuoQS5.edt

Recent ftems | | 2| CuantifilerHP.edt
2| QuantifilerHPQS5. edt

! 2| QuantifilerHuman.edt
Deskiop 2| QuantifilerHumanQs5.edt

— | |2 QuantifilerHybrid.edt
LJ 2| QuantifilerHybridQ35.edt

My Documents 2| QuantifilerMale.edt
——— | 2] QuantifilerMaleQ55. edt
(A | |2 quantfilerTrio.ect
, 2| QuantifilerTrioQS5.edt

Computer
@ File name: | save |
Metwork Files oftype:  Experiment Document Template files (*.edt) - | cancal |

IMPORTANT! Ensure that you give the file exactly the same name as the file corresponding
to the button that you want to replace.

e. Click Save.

Set display defaults

Select data to display in the plate view
1. Click Show in Wells.
2. In the dropdown list, select ([+]) or deselect (D) the data to display in the plate view.

3. Click Set as Default.

Note: The button is inactive before you change a setting, or if you are logged in as Guest.
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Set display defaults

Specify the data to display in the well table
1. Click Show in Table.
2. In the dropdown list, select ([+]) or deselect (D) the data to display in the well table.

3. Click Set as Default.

Note: The button is inactive before you change a setting, or if you are logged in as Guest.

Customize the amplification plot
1. Make changes as described in “Change the appearance of, print, and save plots” on page 58.

2. Select ([v]) or deselect (]j) the data to display in the amplification plot: Threshold and/or Baseline
Start.

3. Click Save Current Settings as Default.

Note: The button is inactive before you change a setting, or if you are logged in as Guest.
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Start the software and select an experiment . ... ... .. . . 24
Navigate the software . .. ... e 26
Specify experiment properties . ... ... e 27
Define samples and view targets . ... i 28
Assign the targets, samples, and standardstowells ........... ... ... ... . i i, 31
Save the plate layout as EDS ortemplate ....... ... i 36
Link your template to a Home screen button ... ... . 36

This chapter assumes that you have prepared a plate according to the instructions in the user guide for
the Quantifiler™ Kit that you are using.

Start the software and select an experiment

24

1.

On the computer desktop, double-click /74 or select Start » All Programs » Applied
Biosystems™ » HID Real-Time PCR Analysis Software » HID Real-Time PCR Analysis
Software. The Login screen should open within 1 minute.

X/
To log in to the software, either:

t* to log in anonyh )
fir dowen list, or enter a neww

Llzer Mame:

Log in as Guest Delete User(s)
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Start the software and select an experiment [ 715

2. In the User Name field, enter your user name or select it from the dropdown list.

You can log in as a guest, but only users logged in with a user name can perform the following
functions:

¢ Edit the names of folders for experiment information import, information export, or data.
* Enable or disable the requirement to enter a user name to start the software.

* Set a plate layout as the default layout (see “Link your template to a Home screen button” on
page 21).
* Configure how data is displayed (see Chapter 3, “Customize the software”).

3. Click OK to open the Home screen.

4. Select an HID experiment.

* C(Click one of the Quantifiler™ kit template buttons, or click Custom Assays.

Quantifiler™ assays Custom assays

Quantifiler® Trio Quantifiler® HP Custom Assays

[¥]

Quantifiler® Duo

Il

[

Quantifiler® Human

Quantifiler® Male

Quantifiler® Male &
Human

|

or

* Inthe toolbar, click the down arrow next to New Experiment, then select the appropriate
experiment.

For custom experiments

IMPORTANT! The custom experiments feature is supported for the 7500 system only.

To perform a non-HID experiment, or a modified experiment, click:

* Custom Assay on the right side of the Home screen.
or
* Assays in the toolbar, then select Custom Assays in the drop-down list.

For information on running custom experiments, see the user documentation for your instrument.
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" Navigate the software

Navigate the software

Each HID Real-Time PCR Analysis Software experiment screen displays instructions for a step in the
experiment. Use the Experiment Menu at the left of any screen to navigate the software.
* C(Click >> (Expand) to expand the Experiment Menu.

) . Experiment Menu <
* (Click << (Collapse) to collapse the Experiment

Menu.

* Click Setup, Run, or Analysis to display screens
used in the corresponding process.

You can access the software screens in any sequence.

To return to the Home screen at any time, click #¢
(Home) at the bottom left of any screen.

Jﬂ Amplification Plot
Temperature Plot

Run Method

= Notification Settings

GO NN

Amplification Plot

Standard Curve

Virtual Standard Curve

&

STR Kit Setup

o

X4 Multicomponent Plot

€

Raw Data Plot

QC Summary

£

¥ Multiple Plots View
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Specify experiment properties |0

Specify experiment properties
1. In the Experiment Menu, select Setup » Experiment Properties.

2. In the How do you want to identify this experiment? pane, enter the name of the plate or
experiment information in the Experiment Name field. Entries in the other fields are optional.

& HID Real-Time PCR Analysis Software v1.0

File Edit Instrument Analysis Assays Tools Help

New Experiment = (5 Open.. [l Save - [ Close .5 Export. - £} PrintReport..

Experiment Menu<« | Experiment: Untitled Type: HID Standard Curve

Experiment Properties

q Enter experiment information.

How do you want to identify this experiment?

* Experiment Mame: |Untit|ed

-

Barcode (Optional): |

Lser Mame (Qptional): |

Comments (Optional):

:‘ Analysis

Note: The name that you enter in the Experiment Name field appears on the data report and on XLS
spreadsheets that you export. If you do not enter a name, Untitled appears on the report and in the
exported spreadsheet.

The following parameters are automatically set:
¢ Experiment Name: Untitled
* Instrument:
— 7500 (96 wells)
- QuantStudio™ 5 (96 wells)
* Experiment Type: Quantitation-HID Standard Curve
* Reagents: TagMan™ Reagents

¢ Ramp Speed: Standard (~1 hour to complete a run for Quantifiler™ HP™ and Quantifiler™ Trio kits,
and ~2 hours for all other Quantifiler™ kits)
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Define samples and view targets

Note: Targets are automatically listed and named. Standards dilutions and an NTC sample are listed by

default for each Quantifiler™ kit. For information about the standard included in the Quantifiler™ kit, see
the kit user guide.

Define samples

1. In the Experiment Menu, select Setup » Plate Setup, then click the Define Targets and Samples

tab.

Experiment: Untitled Type: HID Standard Curve Kit Nam

Define Targets and Samples | Assign Targets and Samples ]

a Instructions: Define the targets to quantify and the samples to testin the reaction plate.

Defined Targets

Define Samples

| Target Name | Reporter | Quencher | Color | Add Mew Sample
I I I I

2. In the Define Samples pane (right side of the screen), specify sample names.
* To define a new sample, do one of the following:
— Click Add New Sample. A new line appears in the Sample Name field.
— In the toolbar, select Tools » Sample Library, then click New.

The default name for the new sample is Sample X (where X=1 or the highest listed Sample #

+ 1). You can enter a new name for the sample. To save the name of the sample for future
experiments, click OK.

* To use a sample from your sample library:
a. Inthe Define Samples pane, click Add Saved Sample.
b. Select the samples to use, then click Add Selected Sample(s).

Note: You can also add a sample to a single well in the Plate Setup screen. See “Assign a new
sample to a well” on page 33.
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Define samples and view targets

Define Samples

Add New Sample | Add Saved Sample | Save Sample | Delete Sample

Sample Mame Co.. | Sampl..
e v | A rerrrorarre
IDuo Standard 4 | + [Standard
\Duo Standard 5 |  [Standard
\Duo Standard & |  [Standard
\Duo Standard 7 | ~ [Standard
\Duo Standard & |  [Standard
INTC [« |nTC

Msampls | v [Unknawn

>

W

e

A gl

3. Select the sample type: Standard, NTC, or Unknown. Unknown is the default sample type for new

samples.

When you assign the sample type, the software automatically assigns the appropriate task to each

target.

Sample Type

LInknown
MTC

Standard ﬁ

4. Repeat steps 2 on page 28 and 3 on page 29 for each sample.

IMPORTANT! List each sample individually. For replicates (identical samples), add the sample
name only once. To assign a replicate to a well in the plate, in step 4 on page 32, select the well,
then select the checkbox next to the sample name.
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Define samples and view targets
View targets
1. In the Experiment Menu, select Setup » Plate Setup.
2. Select the Define Targets and Samples tab.

3. In the Defined Targets pane, view the targets list to verify that you selected the correct experiment
in step 4 on page 25.

Kit Reporter dyes Quencher
Quantifiler™ Trio Small autosomal: VIC™ dye NFQ-MGB
Male (Y): FAM™ dye NFQ-MGB
Large autosomal: ABY™ dye QSsy™7
IPC: JUN™ dye QsY™7
Quantifiler™ HP™ Small autosomal: VIC™ dye NFQ-MGB
Large autosomal: ABY™ dye QSsyY™7
IPC: JUN™ dye QSy™7
Quantifiler™ Duo Human: VIC™ dye NFQ-MGB
Male: FAM™ dye NFQ-MGB
IPC: NED™ dye NFQ-MGB
Quantifiler™ Human Human: FAM™ dye NFQ-MGB
IPC: VIC™ dye NFQ-MGB

Change a color designation

Perform this procedure to change the color that represents a target in the data analysis.

1. Click v (down arrow) in the Color column.

2. Select a color in the dropdown list.
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Assign the targets, samples, and standards to wells

A

Assign the targets, samples, and standards to wells

Open the Assign Targets and Samples tab

Do one of the following to open the tab.

¢ In the Define Targets and Samples tab, click Assign Targets and Samples beneath the Define
Samples pane.

I = IIUIII\IIHTTII I" I H

Assign Targets and Samples

¢ In the Experiment Menu, select Setup » Plate Setup, then select the Assign Targets and
Samples tab.

Experiment: Untitled Type: HID Standard Curve Kit Name : Qt

[ Define Targets and Sarnples Assign Targets and Samples

a Instructions: Standards and NTC are set by default
Selectwells, then assign targets if applicable.

> SelectWells With: E
-

P [Duohendard showinWells v | [Ff] View Legend
- Duo Standard 2
I~ Duo Standard 3 . 1 - 2 [ 3 4 | 8
- Duo Standard 4 " D‘.‘-‘-’ﬁ-f‘"’ DR - Duoihu...

A lbusipc Du&b Duo IPC
I~ Duo Standard 5 e e
— e

HID Real-Time PCR Analysis Software User Guide 31



7  Chapter 4 Select the experiment and set up a plate
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Assign using the plate layout

[ View Plate Layout | View Wel Table |

SelectWells Withk_|- Select Ilem-;l I Selectltern - +

[0 | showinwells ¥ | JFE view Legend N0 setas Def@

1+ | 2z 3 | 4 | 5 | & | 7 | 8 [ & | 10 |

Duo Hum.... Duo Hum.... Duo Hum...
Dua IFC Duo IFC Duo IPC

ol

Assign samples, standards, and NTCs to wells

Assign samples, standards, and NTCs using the View Plate Layout tab.

1. Select the View Plate Layout tab (right side of the screen).

2. (Optional) Select wells with specific characteristics.
a. Click the left Select Wells With button above the layout diagram.

b. Select Sample, Target, or Task in the dropdown list.

0

. Click the right Select Wells With button.

(o}

. Select a specific sample, target, or task.

3. Specify the information to display in the wells:

a. Click Show in Wells to open the dropdown list. Items that are marked with a check ([+]) are
selected for display.

b. Click an item to select or deselect it for display.

4. (Optional) To save your selections as default settings, click Set as Default at the top right of the
View Plate Layout toolbar.

5. Assign standards, NTCs, and unknown samples to wells.
a. To select:
e  Well—Click the well
* Row of wells—Click a letter on the side of the layout
* Column of wells—Click a number at the top of a column

* More than one well, row, or column—Drag the pointer over the wells, letters, or
columns to select

32 HID Real-Time PCR Analysis Software User Guide



6.

8.

Chapter 4 Select the experiment and set up a plate S8

Assign the targets, samples, and standards to wells

b. In the Assign sample(s) to the selected wells pane (left of the plate layout), select the
checkbox in the Assign column corresponding to the unknown, standard, or NTC sample in
the wells. The target for each sample is set by default.

Assign sample(s) to the selected wells.

Assign Sample
r NTC

Note: <Sample 1> is automatically assigned to all wells that are not assigned as standards or
NTCs.

(Optional) To change the quantity of standards, enter the quantity in ng/pL in the Quantity field
in the Assign targets to the selected wells pane. The quantity of standard samples is set by
default.

Repeat steps 4 on page 32 and 5 on page 33 until you assign samples, standards, and NTCs to all
wells that you use in the experiment. You can delete empty wells after data analysis.

Note: If you delete the samples, standards, or NTCs in a well and then restore them, you must
re-enter the well information.

The task for each target/sample combination is set automatically.

Clear all wells that do not contain samples or targets.
a. Select the wells to clear.

b. Right-click, then select Clear from the dropdown list.

Assign a new sample to a well

1.

2.

Double-click the well to open the Add New Sample dialog box.
Click Add New Sample.

The target and task are set by default according to the sample type. To change the sample type,
click the down arrow in the Sample column header, then select the appropriate sample type from
the dropdown list.

To change the sample quantity setting for standard samples, perform step 5 on page 33.
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" 7 Assign the targets, samples, and standards to wells

| Add New Sampie |

Sample Mame Color Sampl...

v |

Target Task Quantity
Target Task Quantity

Comments

Move samples, standards, and NTCs

1. Select the wells for the samples, standards, or NTCs that you want to move.

2. Deselect () the items in the Assign sample(s) to the selected wells pane, or right-click the
wells and select Clear.

3. One at a time, select the new wells for an item that you are moving, then select ([v]) the items in
the Assign sample(s) to the selected wells pane.

Assign using the well table

[ View Plate Layout | View Well Table |

selectWells ¥(h: |- Select tem - ¥ | |- Select ltem - ¥

| showinTabie ¥ )roupﬂyr ([¥H] setas Default D
# Wiell I Eample"‘lBinIngical...l Target Task | Dyes | Quantity |Cnmm5

1 A3 NTC Duo Human NTC YIC-MFQ-M...

-~ o Lo — Pmranr —_— .

Assign samples, standards, and NTCs using the View Well Table tab.

1. Select the View Well Table tab.

Each row in the table represents one well. To group the rows by a characteristic, click the column
header. For example, click Task to group rows by task.

2. (Optional) Select wells with specific characteristics.
a. Click the left Select Wells With button above the layout diagram.

b. Select Sample, Target, or Task in the dropdown list.
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c. Click the right Select Wells With button.
d. Select a specific sample, target, or task.

- Specify the information to display in the table:

a. Click Show in table to open the dropdown list. Items that are checked ([+]) are selected for
display.

b. Click an item to select or deselect it for display.

. (Optional) To save your selections as default settings, click Set as Default at the top right of the
View Plate Layout toolbar.

. Assign samples, standards, and NTCs to wells.
a. Select the wells.

* One well—Click under one of the column headings in the row next to the well location
(for example, to select well A6, click in row A6 under Sample).

¢ More than one well—Drag the pointer over the wells that you want to select, or
Ctrl+Click the wells that you want to select.

b. In the Assign sample(s) to the selected wells pane, select the checkbox in the Assign
column corresponding to the unknown, standards, or NTC sample in the wells. The target for
each sample is set by default.

Assign sample(s) to the selected wells.

Assign Sample
r NTC
I QM Standard 1
I QM Standard 2

Note: <Sample 1> is automatically assigned to all wells that are not assigned as standards or
NTCs.

6. (Optional) To change the quantity of standards, enter the quantity (in ng/uL) in the Quantity field in

the Assign targets to the selected wells pane. The quantity of samples is set by default.

. Repeat steps 1 on page 34 and 5 on page 35 until you assign samples, standards, and NTCs to all
wells that you use in the experiment. You can delete empty wells after data analysis.

Note: If you delete the samples, standards, or NTCs in a well and then restore them, you must
re-enter the well information.
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The task for each target/sample combination is set automatically.

8. Clear all wells not assigned.
a. Click the left Select Wells With button at the top of the table.

b. Select Sample from the dropdown list.
c. In the well table, select the sample names of the wells to clear.

d. In the Assign sample(s) to the selected wells pane, deselect the checkbox in the Assign
column next to the sample name.

Save the plate layout as EDS or template

IMPORTANT! Do not save the experiment to the network folder until the plate run is completed.

1. In the toolbar, click the down arrow next to Save, then select a save option.
* Save—Saves the plate layout as an Experiment Document Single (EDS) file
* Save as—Saves the plate layout as an EDS file with a different name
* Save as Template—Saves the experiment file as a template for future experiments

2. If you want to save the file with a different name, enter the new name in the File Name field.
3. Click Save.

4. Before you start the run, verify that the plate is loaded in the instrument, as described in your
Quantifiler™ kit user guide.

Link your template to a Home screen button

You can link your template to any of the Quantifiler™ assay buttons on the Home screen.

The software will automatically use the template as the default experiment when you click the
corresponding button. You will still be able to use a different template by opening a different
experiment.

1. Before linking, save a copy of the original template.
a. Navigate to <drive>:/Applied Biosystems/7500/config/templates

b. Select Edit » Copy to copy the templates folder.

(2}

. Navigate to a safe location on your computer.
d. Select Edit » Paste to insert a copy of the templates folder in the location that you selected.

2. Link your template to a button on the Home screen.
a. Open the file that you want to link.
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b. In the toolbar, select Save » Save as Template.

Chapter 4 Select the experiment and set up a plate S8
Link your template to a Home screen button "

c. Navigate to <drive>:/Applied Biosystems/7500/config/templates

d. Select the file corresponding to the assay button that you want to replace.

IMPORTANT! Files that contain the “QS5” suffix are templates used by the QuantStudio™
5 Instruments. For example, “QuantifilerTrio.edt” is the template file for the Quantifiler™ Trio
DNA Quantification Kit used by 7500 Instruments; “QuantifilerTrioQS5.edt” is the file used by
QuantStudio™ 5 Instruments.

s | Save As Template @
Save in: | | templates ': |:€”:“|§E|
= 2| QuantifilerDuo.edt
sl Fd 2] QuantifilerDueQS5.edt
Recent ftems | | 2| CuantifilerHP.edt
2| QuantifilerHPQS5.edt
! 2| QuantifilarHuman.edt
Deskiop 2| QuantifilerHumanQ&5.edt
e 2| QuantifilerHybrid. edt
LJ 2| QuantifilerHybridQ55. edt
My Documents 2| QuantifilerMale.edt
— | 2] QuantifilarMaleQ55.edt
[ My 2| QuantifilerTrio.edt
.d‘ﬂ"\.'
2| QuantifilerTrioQS5.edt
Computer
@ File name: | save |
Network Files oftype:  Experiment Document Template files (*.edt) - | cancel |

IMPORTANT! Ensure that you give the file exactly the same name as the file corresponding

to the button that you want to replace.

e. Click Save.
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Save the resUS ... ... e 41

In the Experiment Menu, select Setup » Run Method to open the Run Method screen.

Select the Graphical View tab to open the thermal profile for the assay.

Note: The Graphical View tab displays the run method ramp rate as a percentage when using a
7500 instrument and in degrees Celsius (°C) when using a QuantStudio™ 5 Instrument.

Thermal profile
Quantifiler™ kit
7500 instrument QuantStudio™ 5 instrument
Duo o S
" \ / \‘\~
e 1 foen g
\520°C g \~ﬁu«c
Human Hoking Stage Cucing stags Hoking Slags Gyclng Stags
o] / S ] arcs
1/
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(7500 system only) Set notifications

3. Verify the value in the Reaction Volume field.
® 25 pL for Quantifiler™ Human and Duo kits
e 20 pL for Quantifiler™ HP™ and Trio kits

For more information on run parameters, see the user guide for your Quantifiler™ kit.

(7500 system only) Set notifications

You can set the software to send e-mail notifications for selected events to e-mail addresses that you
specify.

Note: This procedure applies only to the 7500 Real-Time PCR Instrument. It does not apply to the
QuantStudio™ 5 Real-Time PCR Instrument.

IMPORTANT! Notifications cannot be sent unless the computer that performs the run is on an e-mail
network.

1. In the Experiment Menu, select Run » Notification Settings.

2. Enable or disable notifications.

* Enable notifications—In the Run Status pane, select the Enable Notifications checkbox.

% Enable Notifications

or
In the Notifications Settings pane, select Yes next to Enable Notifications.

Notification Settings

Enable Mofifications: @ Yes Mo
Select the events to generate notifications: [~ Instrument Error
" Run Started

¥ Run Completed

* Disable notifications—In the Notifications Settings pane, select No next to Enable
Notifications.

3. Select or deselect the events to generate notifications.

* Instrument Error—When selected, notifies addressees that a run stopped before it was
completed.

* Run Started—When selected, notifies addressees that a run started.
* Run Completed—When selected, notifies addressees that a run is completed.

4. In the Enter email addresses for notifications field, enter the e-mail addresses that notifications
will be sent to. Follow the format shown on the screen. Enter a comma between addresses.
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Start or stop the run

5. Define the outgoing server. If you need information about the server, contact your network system
administrator.

a. Outgoing Server (SMTP) field —Enter the name of the outgoing server.
For example: smtp.mycompany.com

b. Server requires an encrypted connection?—If the outgoing server requires an encrypted
connection, select Yes.

c. Server requires authentication—If the outgoing server requires authentication to receive the
e-mail from the instrument, select Yes, then enter the authentication user name and password
in the dialog box.

Start or stop the run

IMPORTANT! If the computer that performs the run is on a network, avoid excess use of the network
during a run.

Note: You can set analysis parameters before or after you run a plate. To set parameters before you run
a plate, see Chapter 6, “Select analysis settings and thresholds”.

Start a run

In the Experiment Menu, select Setup, select any screen, then click START RUN at the top-right
corner.

Alternatively, click Run, select any screen, then carefully click START RUN at the top-left corner.

The green START RUN button becomes a red STOP RUN button, and the run begins.

Note: If you double-click the START RUN button, it may not become a STOP RUN button, but the run
proceeds normally.

Stop arun

When you start a run, the green START RUN button becomes a red STOP RUN button.

In the Experiment Menu, select Setup, select any screen, then click STOP RUN at the top-right corner.
Alternatively, click Run, select any screen, then carefully click STOP RUN at the top-left corner.

STOP RUN €3

The run immediately stops.
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(7500 system only) Monitor a run

Note: This procedure applies only to the 7500 Real-Time PCR Instrument. It does not apply to the
QuantStudio™ 5 Real-Time PCR Instrument.

During a run, you can access the amplification plot, temperature plot, and run method.
In the Experiment Menu, select Run, then click the data to view.

¢ Amplification Plot—Displays amplification plots of reactions

¢ Temperature Plot—Displays temperature plots of reactions

¢ Run Method—Displays the run method and allows you to edit the run method during the run

Save the results

After a run is complete, the HID Real-Time PCR Analysis Software automatically performs analysis and
saves the initial results file.

If you modify the plate (for example, if you remove a well from analysis and reanalyze the results), the
software does not automatically save the changes. After reanalysis, the HID Real-Time PCR Analysis
Software prompts you to save the results.

After the run, see Chapter 7, “Enhance data analysis” to view and manage the results.
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IMPORTANT! All default settings shown in this guide and in the software screens are for illustration
only. For your experiments, set the parameters and thresholds according to your laboratory protocol.

Before analyzing data from a completed run, you can edit values for the analysis parameters:

¢ Cythreshold, baseline start cycle, and end cycle

¢ HID flag thresholds

* QC flag thresholds
The Analysis Settings screen also contains the area where you set the parameters for the Dilution
Calculation tool that is used to calculate a dilution scheme for downstream amplification. For more

information about the Dilution Scheme pane, see “Edit dilution settings for individual samples” on
page 66.

Open analysis settings

1. In the Experiment Menu, select Analysis, then select any one of the data displays.
¢ Amplification Plot
¢ Standard Curve
¢ Virtual Standard Curve
* Multicomponent Plot
¢ Raw Data Plot
¢ QC Summary
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View and edit CT settings '

2. Click Analysis Settings at the top-right corner of the screen to open the Analysis Settings dialog
box.

Analysis Seftings

% Analysis Settings for Untitled

F[ HID Settings | Cr Seftings | Flag Settings L

View and edit Cy settings

Note: The recommended Cr settings for each Quantifiler™ kit are included in the experiment templates
provided with the software and in the kit user guides. The recommended settings are those that were
used in the validation experiments performed for each kit by Thermo Fisher Scientific.

1. Select the Ct Settings tab to view the settings for Cr.
The default system settings are:
* Manual Ct Threshold = 0.2
* Manual Baseline Start Cycle = 3
* Manual Baseline End Cycle = 15
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2. To change the settings, click Edit Default Settings, enter the new values, then click Save

Changes.

L a

2 Edit Default Cr Settings

Editthe default C1 seltings, then click "Save Changes.”
Editing the default Ct seltings does not affect wells with
advanced analysis seltings.

Threshold: 0.2

| Automatic Baseline

Baseline Start Cycle: | 3144 End Cycle: | 152

| Save Changes | | Cancel

3. To analyze the data with new settings, click Apply Analysis Settings at the bottom of the Analysis

Settings dialog box.

Enter HID settings

1.

44

Select the HID Settings tab to view the Dilution Scheme, HID Flags, and HID Flag Settings
panes.

For more information about settings in the Dilution Scheme pane, see “Edit dilution settings for
individual samples” on page 66.

In the Use column in the HID Flags pane, select the checkbox for each flag that you want to
include in the analysis.

You can use a flag to identify quality issues and help to interpret results for wells. Flags can
indicate samples that may require further attention. You can exclude wells from data analysis (see
“Omit wells from analysis” on page 56).

Enter threshold settings for the flags that you select.
a. In the HID Flags pane, select the flag of interest.

b. In the HID Flag Settings pane, enter in the corresponding fields the values that you want to
use.
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Repeat steps 2 on page 44 and 3 on page 44 until you enter settings (or view the default settings),

for all the flags that you select.

Note: To save your HID flag settings for future use, save the experiment as a template before you
start the run (see “Start or stop the run” on page 40).

4. To analyze the data with new settings, click Apply Analysis Settings at the bottom of the Analysis

Settings dialog box.

& Analysis Settings for Untitled

[ HID Settings | C1Settings | Flag Settings

Dilution Scheme

Pipetting Overage |D.U %
Minimum Pipetting Yolume I'l 0 uL

Dilution Method

" One Step Dilution Only

¢ System Select

Maximum First Step Dilution Factor |1 1] X

| Revert to Defautt Analysis Settings ]

Maximum Sample Yolume [10.0 pL
-HID Flags -
| Select an HID flag to specify its settings
‘HID Flag Description Use
IPCCT Internal PCR Control C1value Il
MNTCCT Non-Template Control sample amp.(| M
LOWGQT Low Quantity of DNA
HIGHQT  |High Quantity of DNA C
SLOPE MNaon-optimal slope of the Standard .. | ™
R* Low Standard curve R*value WV
4

- HID Flag Settings -
Quantifiler Duo Kit:

Human Target has a Ctvalue less than

Male Target has a Ctvalue less than

Quantifiler Human Kit

Hurnan Target has a Ctvalue less than

Nuantifilar Mala Kit

| &pply Analysis Settings | Cancel |

HIGHQT

The HIGHQT flag indicates that the quantity, or mean quantity of sample replicates, is above a

threshold that you set.
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Enter HID settings
IPCCT
The IPCCT flag indicates one of the following:
Well contents Cause Comment
Unknown The IPC (Internal PCR Control) Ct We strongly recommend that you base the
sample value is greater than the average threshold setting on validation data produced by
of the IPC Cy values for all the your laboratory.
standards plus the threshold that you

For information on interpreting the IPCCT flag for

set. Quantifiler™ kit experiments, see your kit user guide.
Standard or | The IPC (Internal PCR Control) Ct In Quantifiler™ kit experiments, the IPC target
NTC value is above the maximum or below | amplification should be within an expected range.
the minimum that you set. Low or no IPC amplification can indicate the

presence of PCR inhibitors, incorrect experiment
setup, or reagent or instrument failure.

LOWQT

The LOWQT flag indicates that the quantity, or mean quantity of sample replicates, is below a threshold
that you set.

NTCCT

The NTCCT flag refers to the C+ value of the NTC (non-template control). No amplification of human
and/or male targets should occur in NTC wells.

MTFR flag and M:F ratio display

46

The MTFR (Male to Female Ratio) is expressed as 1:X. A well is flagged if X is greater than the threshold
that you set. For example, if you set the MTFR flag threshold at 1:10, then a sample that contains

5 ng/pL of male DNA and >55 ng/pL of human DNA generates an MTFR flag. The flag for this condition
is a yellow triangle (/) in the Plate Layout or Well Table tab, and a red octagon (&) in the Analysis
Summary pane (see Chapter 7, “Enhance data analysis”.

Samples that generate the MTFR flag are labeled Thresholds Not Met in the Analysis Summary pane
of the QC Summary tab. The MTFR flag indicates samples that might require Yfiler™ kit amplification
because of low quantities of male DNA relative to female DNA. Autosomal amplification of these
samples may result in partial to no profile for the secondary (male) contributor.

In contrast, the M:F ratio display does not have an associated flag. The M:F ratio is also expressed as
1:X and is displayed in the M:F ratio column of the well table only if X is greater than or equal to the
threshold that you set for the M:F ratio display.

The M:F ratio display threshold is expressed as 1:X where X must be less than or equal to the X value
for the MTFR flag. For example, if you set the M:F ratio display to 1:1, then the MTFR flag must be
set to 1:>1. Samples with ratios greater than the MTFR flag display the MTFR flag and display the
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calculated M:F ratio. The M:F Ratio Display function alerts you to male and female mixtures before STR
analysis.

Table 3 Results of example M:F and MTFR settings

HID setting
Male DNA | Female DNA | Male:Female ratio, M:F Ratio M:Fratio | y\irep flag?
q MTFR flag d|sp|ay?
display (1:X) X
_ (1:X) X =
1 ng/pL 1 ng/pL 1:1 1 1 Yes No
1 ng/pL 2 ng/uL 1:2 1 1 Yes Yes
1 ng/pL 1 ng/pL 1:1 1 2 Yes No

SLOPE

The SLOPE flag indicates the PCR amplification efficiency for the experiment. The amplification
efficiency is calculated using the slope of the regression line in the standard curve. The standard wells
are flagged if the slope is not between the minimum and maximum values that you set.

The standard curve is derived from a serial dilution set of standards that contain a range of known
quantities. Amplification results for these standards are used to generate a curve.

A slope of —3.3 indicates 100% amplification efficiency. For more information on the standard curve and
slope, see the following kit user guides:

® Quantifiler™ Human DNA Quantification Kit and Y Human Male DNA Quantification Kit User Guide

* Quantifiler™ Duo DNA Quantification Kit User Guide

R2
The R? flag indicates the regression coefficient calculated from the regression line of the standard
curve. The R? value indicates the closeness of fit between the standard curve regression line and
individual Ct data points from the standard reactions. A value of 1.00 indicates a perfect fit between the
regression line and the data points.

YINT

The Y-intercept value of the standard curve indicates the expected Cy value for a sample with a
quantity of 1 (for example, 1 ng/uL). The YINT flag can assist in evaluating standard performance
and serial dilution preparation. Your laboratory can perform validation studies to determine a range
for the Y-intercept. Additionally, you can set the HID flag values for each Quantifiler™ kit and the HID
flag values for each target (human and male) in the Quantifiler™ Duo assay. A YINT flag may indicate
incorrectly prepared standard concentrations, degraded standard, or other preparation errors.
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Enter flag settings

Chapter 6 Select analysis settings and thresholds
Enter flag settings

1. Select the Flag Settings tab to view and define instrument, sample, and data collection flags.
Flags not used in the analysis are gray. Table 4 explains the flags.

2. In the Use column, select each flag that you want to include in the analysis.

3. Specify the conditions that generate a flag: In the Condition column dropdown lists, select
conditions (< > =), then enter the corresponding values in the Value column.

4. To omit the wells that have a flag from the analysis, select the corresponding Reject Well

checkboxes.

5. To analyze the data with new settings, click Apply Analysis Settings.

& Analysis Settings for Untitled

!

HID Settings | Ct Settings | Flag Settings |

Table 4 QC flags

48

Flag Description Use Aftribute Condition Value Reject Well
AMPNC Amplification in ne... O cr < ———— v | 35
1 .
BADROX Bad passive refer... Bad passive FEQ_. v |UE O
-“.-‘-l—n_g—l-/
BLFAIL Baseline algorith... O

Flag Description
AMPNC Amplification in non-template control
BADROX Bad passive reference signal
BLFAIL Baseline algorithm failed
CTFAIL Cr algorithm failed
DRNMIN Define acceptable delta Rn based on Ct range
EXPFAIL Exponential algorithm failed
OFFSCALE Fluorescence is offscale
HIGHSD High standard deviation in replicate group
PRFLOW Low passive reference signal
NOAMP No amplification
NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
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Add a virtual standard curve to the experiment

Table 4 QC flags (continued)

o

Flag Description
OUTLIERRG Ouitlier in replicate group
PRFDROP Passive reference signal changes near Ct
THOLDFAIL Thresholding algorithm failed

Add a virtual standard curve to the experiment

If you are using a virtual standard curve to analyze experiments, use the software to create the virtual
standard curve, then assign it to your experiments as needed or export it for further use.

Guidelines for using virtual standard curves

* The software will not analyze an experiment using a virtual standard curve if:
— The plate layout of the experiment contains wells that are configured with the Standard task

type.

— The expiration date specified for the virtual standard curve has expired.

— The Quantifiler™ kit specified for the experiment and the curve do not match.

* When analyzing an experiment using a virtual standard curve, all Unknown samples generate the
IPCCT (Internal PCR Control Cy) flag by default.

* Laboratories should perform internal validation studies to ensure that implementation of a virtual
standard curve is appropriate and generates reliable downstream data. For optimal results, virtual
standard curves should be evaluated independently for each real-time PCR instrument. We
recommend the re-evaluation of virtual standard curves with each new lot of quantification kit.

Create a virtual standard curve

IMPORTANT! To create the virtual standard curve, you must know the slopes and y-intercepts of the
targets for the kit that you are using.

1. In the Experiment Menu, select Analysis » Virtual Standard Curve.

2. Click Add Standard Curve to Experiment in the top-left corner to open the Virtual Standard
Curve Library dialog box.

3. Click New to create a new virtual standard curve.

4. Specify the settings for the virtual standard curve.

a. Enter a name for the curve.

b. (Optional) Select the Is Standard Curve Default checkbox to analyze all new experiments of
the same selected kit type (see substep 4d on page 50) using the virtual curve.
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Add a virtual standard curve to the experiment

c. Select the date on which the curve expires. When the curve expires, the software can no
longer use it to analyze data.

d. Select the kit to which the virtual standard curve applies.

e. Enter the slope and y-intercept for each target of the selected kit.

f. Enter any comments for the virtual standard curve, then click OK to save it to the library.

r

@ Create New Standard Curve 3
Enter all the information for the new Virtual Standard Curve, then click = Required
OK to save.

Virtual Standard Curve *
Is Standard Curve Default? [V
Expiration Date * Jun 15, 2017 -
Select Kit* Quantifiler Trio v
Targets *
TY T.Large Autosomal

Y-intercept 00

Slope: 0.0

T.Small Autosomal
Y-Intercept 0.0

Slope: 0.0

Comments

Y-Intercept 0.0

Slope; 00
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Add a virtual standard curve to the experiment

Apply a virtual standard curve to an experiment

Before you apply the curve

The software cannot use a virtual standard curve to analyze an experiment that already contains wells
that are assigned the Standard task. Therefore, before applying a virtual standard curve, you must omit
or reassign the task of any Standard well on the plate layout.

Option See
Omit wells from the analysis “Omit wells from analysis” on page 56
Reassign the task assignment of a well “Assign samples, standards, and NTCs to wells” on page 32

Apply a standard curve

IMPORTANT! Before you apply a virtual standard curve, you must omit or reassign the task of any
Standard well on the plate layout.

To apply a virtual standard curve to the open experiment:

1. In the Experiment Menu, select Analysis » Virtual Standard Curve.
2. Click Add Standard Curve to Experiment in the top-left corner of the screen.

3. In the Virtual Standard Curve Library dialog box, click Add selected Virtual Standard Curve.

Note: When analyzing an experiment using a virtual standard curve, all Unknown samples generate
the IPCCT (Internal PCR Control Cy) flag by default.

Automatic analysis using a default virtual standard curve

If you select the Is Standard Curve Default checkbox in the settings of a virtual standard curve, the
software automatically analyzes all new experiments using that default virtual standard curve unless:

* The plate layout of a new experiment contains wells that are configured as standards.
* The expiration date specified for the virtual standard curve has passed.

|s Standard Curve Default 2
Expiration Date * Jan 24 2017 -

* You select the Is Standard Curve Default checkbox for another virtual standard curve (or the
option is deselected for the existing virtual standard curve).

HID Real-Time PCR Analysis Software User Guide 51



View the analysis results

Enhance data analysis

View the analysis resURS . .. ... . ot i e e e e 52
Interpret QC flag information . ... ... i e 55
Omit wells from analysis .. ... ..ot i et et e et ettt 56
Omit targetsinan experiment Well . ... ... i i i e e e 57
Examine the Degradation INdeX . ... ... ... i i e et et e 58
Change the appearance of, print,and save plots ......... ... it 58

Flagged wells
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To view the results of the data analysis:

1.

In the Experiment Menu, select Analysis » QC Summary to open the QC Summary screen.

2. Select the Analysis Summary tab.

The tab displays the HID-specific flags that you selected to include in the data analysis and
indicates the number of wells that meet or do not meet the threshold that you set. The symbols in
the Analysis Summary tab are described in Table 5.

Note: If the screen resolution is not set to 1280 x 1024, the Analysis Summary tab may not be
properly displayed.
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Chapter 7 Enhance data analysis
View the analysis results

Click a link below to highlight samples that meet'do not meet all thresholds.

"One or more instrument-related QC flags are fired. Click QC Flags Detailto see ¢

standard Curve

Slope

Guant Male

Quant Human

@ o

Standard Thresholds Met @ Thresholds Not Met
PCCT 0 | 32
NTC Thresholds Met IO Thresholds Mot ket
IPCCT 0 2
NTCCT 0 2

Table 5 Symbols in the Analysis Summary tab

P/

Location

Symbol

Description

Standard Curve bar

Green square ()

A value for Slope,
threshold

R2, or Y-Intercept meets the

Red octagon (@)

A value for Slope, R2, or Y-Intercept does not meet the

threshold

Thresholds Met columns

Hyperlinked numbers

The number of wells that meet the thresholds for a flag

value

Thresholds Not Met
columns

Hyperlinked numbers

The number of wells that do not meet the thresholds

for a flag value

Standard Curve bar

The Standard Curve bar contains the SLOPE, R?, and Y-Intercept flags. Click the column heading for

a red octagon (@) to highlight in the plate layout the wells represented in the standard curve. This

graphical view simplifies the identification of wells that require further analysis using your laboratory

protocol.
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Standard bar

The Standard bar reports the IPCCT flags for all the wells on the plate that you designated as sample
type Standard. Click the number in the Thresholds Not Met column to view the wells that do not
meet the IPCCT threshold in the plate layout or well table format. You can use the amplification,
multi-component, or raw data plots to troubleshoot the data for these wells. You can examine the wells
that meet the threshold by clicking the number in the Thresholds Met column.

NTC bar

The NTC bar reports the IPCCT and NTCCT flags for all the wells on the plate that you designated

as sample type NTC (non-template control). Click the number in the Thresholds Not Met column to
view the wells that do not meet the IPCCT or NTCCT threshold in the plate layout or well table format.
You can use the amplification, multi-component, or raw data plots to troubleshoot the data for these
wells. You can examine the wells that meet the threshold by clicking the number in the Thresholds Met
column.

Unknown bar

The Unknown bar reports the IPCCT, HIGHQT, LOWQT, and MTFR flags for all the wells on the plate
that you designated as sample type Unknown. The HIGHQT, LOWQT, and MTFR (Male to Female
Ratio) flags indicate that the quantity of DNA or ratios of male to female DNA in Unknown samples may
require additional attention. Numbers below the flag indicate the number of wells that do not meet the
threshold.

Note: The MTFR flag is not available in Human or HP™ kit experiments.

Click the number in the Thresholds Not Met column to view the wells that do not meet a threshold in

the plate layout or well table format. You can use the amplification, multi-component, or raw data plots
to troubleshoot the data for these wells. You can examine the wells that meet the threshold by clicking
the number in the Thresholds Met column.

Instrument-related flags

A message may be displayed to indicate that one or more of the instrument-related flags is generated
by a potential problem with the instrument. The message prompts you to select the QC Flags Details
tab to view the flags.

Wells automatically omitted

54

In certain rare instances, such as assignment of targets to empty wells, the HID Real-Time PCR
Analysis Software may automatically omit wells of a Quantifiler™ kit run.

The software automatically omits wells that may prevent the completion of data analysis, so that
analysis can continue for the rest of the wells in the plate. These wells are indicated by a red
exclamation point above the Analysis Summary tables. You can examine the automatically omitted
wells by clicking the number next to the exclamation point.

[1] Automatically Omitted : 1
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Interpret QC flag information

1. In the QC Summary screen, click the QC Flags Detail tab to view all QC flags (both general and
HID).

2. Click a flag to select all affected wells in the plate layout, and to open a brief description of the flag
and wells.

3. (Optional) In the QC Flags Details description box, click the hyperlink to open the software help
system.
The software help system provides information for troubleshooting the flag and the criteria used
for analysis. (For more information about the flags, see Chapter 6, “Select analysis settings and
thresholds”.)

Analysis Summary [ac Flags Dtail

Flag Details
Flag: MName Frequency Wells
| | -]
BADROX Bad passive reference signal I
QOFFSCALE  |Fluorescence is offscale 1]
NOISE Maise higher than others in plate 1 E2
SFIKE Moise spikes 0 Ll

Flag: OFFSCALE—FIuorescence is offscale

Flag Detail: Fluorescence exceeds the instrument's maximum
detectable range for one or more cycles.

Flagged Wells: None
YWiew OFFSCALE Troubleshooting Information

For information about how to view and edit sample information, see “Change the appearance of a plot”
on page 58.
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Omit wells from analysis

1. In the Experiment Menu, select Analysis.

2. To view data from individual wells, select any one of the plot screens.
* Amplification—Amoplification vs. cycle and amplification vs. well
¢ Standard curve —C+ vs. quantity of standards, flagged samples, and unflagged samples
* Multicomponent plot—Fluorescence vs. cycle of all reaction components
¢ Raw data plot—Amplitude vs. filter

* Multiple plots view—Amplification, standard curve, multicomponent, and raw data plots in
one pane

Note: If no data are displayed, click Analyze.

3. Omit wells using the well table or plate layout.

* Well table —Select the View Well Table tab, then select the Omit checkbox for each well to
exclude from the analysis.

Note: If the Omit Well column is not visible in the table, click Show in Table, then select
Omit Well to show the column.

View Plate Layout | View Well Table | Dilution Setup |

SelectWells With: |- Select Iltem -

Show in Takle ¥ | Group By ¥ |

# | Well Omit Flag Sample ... | TargetMN... Task Dyes
2 Al Duo Stand... Duo IPC UNEKNOWN MNED-NFQ-..
i A Duo Stand... Duo Male  STANDARD FAM-NFGQ-...
4 A2 lk Duo Stand... Duo Human STANDARD WIC-MNFQ-M...
5

A2 F] Duo Stand... Duo IPC UNKNOWN  NED-NF@-...

* Plate layout—Select the View Plate Layout tab. For each well to omit, right-click the well,
then select Omit » Well.

. Fit Plate
0 showinwels ¥ | FE
Full Screen
Omit
1 2 3 [
L'1(1::1ch.lde=

OH St... | QH St...
A Quant .. Guant .. Save As...

n=nt MAnant

Print Preview,..

QH St.. % Print...
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Omit targets in an experiment well

4. Click Analyze to reanalyze the experiment data with the omitted wells excluded from the analysis.

5. Review the data that are analyzed without the omitted wells.

Omit targets in an experiment well

For Duo, HP™, and Trio kit experiments, you can omit one of the standard targets in a well from analysis.

1. Right-click a well with a standard target that you want to omit.

Note: You can omit only one target from one well at a time.

2. Select Omit from the dropdown list, then select a well or an individual target.

* Well—Select a well to omit all targets from the well. The E (well omitted) icon appears in the
well.

* Individual target—Select the name of the target (for example, Duo Human) to omit a specific
target from the well. The individual target omitted icon (for example, m for Duo Human
omitted) appears in the well.

3. Click Analyze to reanalyze the experiment data with the omitted targets excluded from the

analysis.
1 2 3 4 A E
Duo Stand.. COI:"‘,-"
Duo Human
Al Zoom In
Duo Male Zoom Qut
Fit Plate
Duo Stand..
. D Full Screen
Omit 4
Duo Male WE”
[Nclude [QUO Human
Duo Stand.. Cave As. B 10 Male
N Duo Human

Figure 7 Example—Duo kit experiment
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Examine the Degradation Index

The Degradation Index refers to the data observed when a sample may be degraded: a decrease in
measured amount for large DNA fragments compared to small DNA fragments. While DNA degradation
is not the only theoretically possible mechanism for a decrease in amount, it is the predominant
mechanism in the absence of inhibitors. The Degradation Index is for use as a general indicator of
whether large DNA fragments may perform more poorly in STR reactions. Evaluate the Degradation
Index in conjunction with the IPC C+.

The Degradation Index is automatically calculated by the HID Real-Time PCR Analysis Software using
the following formula:

Small autosomal target DNA conc. (ng/uL)

Large autosomal target DNA conc. (ng/pL)

The Degradation Index value is displayed in the Well Table view in any of the analysis screens (you may
have to scroll to the right to display it.)

See the Quantifiler™ HP and Quantifiler™ Trio DNA Quantification Kits User Guide for more information
on:

® The Degradation Index
* Evaluating the HID Real-Time PCR Analysis Software quality indices to identify degraded samples

Change the appearance of, print, and save plots

Change the appearance of a plot
1. In the Experiment Menu, select Analysis, then select any one of the plot screens.

2. In the plot screen, locate the icon bar above the plot.

PP AR E

3. Click I~ (Hide) to hide the plot legend.
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4. To change the appearance of a plot, click &2 (Edit Plot Properties) to open the Plot Properties
dialog box. Three tabs are available.

Plot Properties

Plot Properties
.G General General
Title Label Label
Text | Amplification Plot Label | Cycle Label | &Rn
Font | select Font | select Font | setect
color| [l 0.0,0 coor | 0,00 coior |l o.0.0
Show Title
Tick Marks Tick Marks
Show major tick marks Show major tick marks
Show minor tick marks Show minor tick marks
Show major tick mark labels Show major tick mark labels
Show minor tick mark labels Show minor tick mark labels
Range Range
Auto-adjust range Auto-adjust range
[ o || cancel | [ o || cancel | oK || cancel

5. Select the appropriate tab to enter the values that you want to use to plot the data.

6. Click OK to apply the changes.

Select the wells to include in the report
1. In the Experiment Menu, select Analysis, then select any one of the plot screens.

2. Select the wells to include in the report, using the View Plate Layout tab (see step 4 on page 32)
or the View Well Table tab (see step 4 on page 35).

Print or save a plot
1. To print a plot, click &} (Print) .
2. To save a plot as a JPG file, click i (Save).

Printed plots and JPG files include the slope, Y-intercept, and R2.
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After the HID Real-Time PCR Analysis Software completes analysis and after you review the data, you
can generate a customized report (PDF file), then save or print the report.

You can also export and save data in these formats:
Excel™ (XLS)
PowerPoint™ (PPT)

Text (TXT)

Export data

1.

2.

60

In the Experiment Menu, select Analysis.

Select any one of the plot screens, then click View Plate Layout or View Well Table.

Highlight the wells to export.

In the toolbar, click £# (Export) to open the Export Data screen, then select the Export
Properties tab.

Select one or more checkboxes for the type of data to export.

Amplification Data—Data that was collected during the cycling or amplification stage.
Multicomponent Data—Fluorescence data for each dye, for each cycle.

Raw Data—Raw fluorescence data for each filter, for each cycle.

Results —Results of the analysis.

Sample Setup—Setup information such as well, sample name, and sample color.

STR Dilution Setup —Sample dilution worksheet to prepare samples for amplification. For
more information, see Chapter 9, “Generate dilution and reaction worksheets for STR setup”

STR Reaction Setup—STR reaction setup worksheet to prepare samples for amplification.
For more information, see Chapter 9, “Generate dilution and reaction worksheets for STR
setup”
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Export data
Export Properties I Customize Export 1
™ Sample Setup ¥ Results -
[T Raw Data [™ Multicormponent Data
1. Select data to export:
[~ Amplification Data [~ STR Dilution Setup
[ STR Reaction Setup
2. Select one file or separate files: IDnE File - I Selectio export ali data in ane fife or In separate files for each data vpe.
3. Enter exportfile properties:
Esxport File Name: |U3BDsgDun_dala File Type: 'a‘;lj (*xls) ¥
Export File Location: |C:U\pp\ied Biosysterns\7a00\experirments | Browse |
[T Openfile(s) when expattis complete _I
v

R}Save current setings as the defaulf Start Export I | cancel ]

6. From the dropdown list, select Separate Files or One File.

7. Enter the export file properties.
¢ Export File Name —Enter the name of the report.

* File Type—Select the type of file. See the online help system for information on creating PPT
slides.

¢ Export File Location—Enter the filepath for the save location.

8. (Optional) Customize the data.
a. Select the Customize Export tab.

b. Select the information that you want to export.

Note: Sample setup should be exported only as a TXT file.
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c. To sort data in the export by column, click the column header (for example, click Well to sort
the data by well).

Export Properties T Customize E',‘«{pn:}rt}=

Customize: ‘Sample Setup w

Organize Data Sample Sel
(%) Down Rows Well
Al
Select Sample Setup Content Al
Al
All Sample Setup Fields A2

9. Click Start Export to export the data to the files that you selected.

Print a report

1.

2.

62

Select Plate Setup » Assign Targets and Samples.

Click View Plate Layout or View Well Table.

Select the wells to include in the report.

In the toolbar, click £} (Print Report) to display the Print Report screen.

Select the checkbox for each data topic that you want to include in the report.

Note: Exported standard curves do not include unknown data points.
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Print a report

Print Report

v Experiment Summary

¥ Standard Curves

¥ Plate Layout

V¥ Amplification Plot (ARn vs. Cycle)
¥ Amplification Plot (Rn vs. Cycle)
V¥ Amplification Plot (CTvs. Well
¥ Results Tahle (By 'Well)

V¥ QC summary

u Select data for the report. Click "Preview Report” to preview the report content. Click "Print Report® to send the n

Information about the experiment, including experiment name, experiment b
name, run information, and comments.

The hestfit line using Ctvalues from the standard reactions plotted agains
guantities.

An illustration ofthe wells in the reaction plate. Displays the contents assiar

Data collected during the cycling or amplification stage. Displays haseline-«
normalized reporter (ARN) plotted against cycle number.

Data collected during the cycling or amplification stage. Displays normalize
plotted against cycle numhber.

Data collected during the cycling or amplification stage. Displays CT plotted
numher.

Atable of experiment results for each well, including sample, target, task, o1

Atahle offlags applied to wells in the experiment, including flag description
occurrence,and a list of flagged wells.

6. (Optional) Click Print Preview to preview the report content.

7. Select a print option.

8. Select Save to save the report, or select Print to print the report.

QD]

Note: If you do not enter a name in the Experiment Name field of the Experiment Properties screen,
the experiment name on the report is “Untitled.”
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After a run is complete, you can use the HID Real-Time PCR Analysis Software to generate dilution and
reaction worksheets for STR setup.

The software generates dilution and reaction setup worksheets to perform calculations for the kits that
you select from the STR Kit Library, and the kit information and default dilution settings that you specify.

See Appendix D, “Configure STR library and default dilution settings” to:
* Enter, edit, or delete kit information in the STR Kit Library
* Set default dilution settings for the calculations

Add kits to an experiment
Before exporting worksheets, add kits to an experiment.
1. Open the experiment of interest.
2. In the Experiment Menu, select Analysis » STR Kit Setup.

3. In the STR Kit Setup pane, click Add Kit to Experiment to open the Kit Dilutions Library screen.

STR Kit Setup

Add Kit to Experiment ave Kitto Librar lelete Kit fror Jeriment >

| Kit Name [% ' Last Modified Date ]

& Kit Dilutions Library
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Chapter 9 Generate dilution and reaction worksheets for STR setup M
Select unknown samples for amplification T

4. Select the kits to use in the experiment. To edit kit information, see “Configure the STR Kit Library”

on page 82.
Kit Mame Last Mo
AMpFESTRE® Identifiler® L} Oct 6, 2008
AMPFISTRE® Profiler Plus® ’ Octg, 2003
AmMpFESTR® COfiler® Sep 8, 2008
STR Kit Mame IAmpFESTR ldentifiler®

Target Conc. {(ngful)y |01

5. Repeat steps 2 on page 64 through 4 on page 65 until you select all the kits to use in the
experiment.

6. To delete a kit from the experiment (not from the Kit Dilutions Library), select the kit to delete, then
click Delete Kit from Experiment.

Select unknown samples for amplification

After adding kits to an experiment, select the unknown samples for amplification and associate samples
with kits.

1. In the Experiment Menu, select Analysis, then select any analysis screen.

2. Select the View Well Table tab.

Note: If the well table does not display a column for the selected STR kit, click Show in Table,
then select the kit name from the list of available columns.

HID Real-Time PCR Analysis Software User Guide 65



m Chapter 9 Generate dilution and reaction worksheets for STR setup
" Edit dilution settings for individual samples

3. Select the checkbox for the unknown sample to use and the STR kit with which to use the sample.
If a sample is not for amplification (for example, a standard), it is not available for selection.

AmMpFISTRE ldentiiler®

|-
]
v
r

To select all of the samples for a kit, select the checkbox next to the kit name at the top of the
column.

Note: The software automatically assigns the same kit for replicates.

4. Select the Dilution Setup tab to view the dilution scheme and the STR kits that you selected for
each sample.

5. Repeat steps 2 on page 66 and 3 on page 66 for each unknown sample and kit.

Note: You cannot select an STR kit for standard or NTC sample types. Dilution calculations apply only
to the unknown sample (Human or Male) target in the wells, not to standards or NTCs.

Edit dilution settings for individual samples
If needed, edit the default dilution settings for samples.
1. Select the View Well Table tab.
2. Select the sample of interest.

3. In the toolbar at the top of the well table, click Edit Dilutions to open the Edit Target Dilution
Details screen.

[ View Plate Layout | View Well Table | Diution Setup |

fﬁ-‘-‘.‘_
Show in Table ¥ I Group By Edit Dilutions D

—

‘ Select Wells Wil
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Chapter 9 Generate dilution and reaction worksheets for STR setup [0
View the dilution scheme

4. View or edit the settings as needed.
* Min. Pipetting Vol. —The minimum quantity to pipette.
* Max. Sample Vol.—The maximum volume of available sample.
¢ Dilution Factor—For example, enter 10 for 10-fold dilutions.

KOS

* Target Conc.—The amount of target DNA that you want to use divided by the total sample

volume per STR reaction.
* # Replicates—The number of identical reactions.

H! Edit <#6> Target Dilution Details LI
Settings
Sample Concentration: 6.533 na/pl
Min Pipetting Vol | 1.0 gl Max Sample Vol | 10.0 pl Dilution Factaor 10
Kits
it Target Conc. (nafpl) #Replicates DNA to D1 Diluentto D1 D1to D2 Diluentto D2
AMpFISTR® Identifiler® W 0.1 1| 1 1.7 9.4
| Add | | Delete | | save | | cancel |

Note: If you quantify replicates, the Edit Target Dilution Details screen displays the sample

concentration or the mean sample concentration.

Note: The software displays target sample concentration based on maximum sample volume, number
of replicates, sample volume per STR reaction, and pipetting overage that you set if the desired target

concentration cannot be reached.

View the dilution scheme

View the dilution scheme to ensure that the settings are appropriate for your experiment.

1. In the Experiment Menu, select Analysis.
2. Click any plot to open a plot screen.
3. Select the Dilution Setup tab to open the Dilution Setup screen.

4. Review the settings for downstream reactions.
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M Chapter 9 Generate dilution and reaction worksheets for STR setup
U Export dilution and reaction worksheets

View Plate Layout | View well Table | Dilution Setup |
STR Kit Sample Name | Quantity Mean| IPC Ct | STR Target Co... | STR Input Amount (ng) DA to D1 Diluentto D1 | D1toD2 Diluentto D2 # of STR Rxn.
AMpFISTR® Identifiler®  |[#6 6.563336906... |26.254..|01 1.00 1.0 64.3 10.0 0.0 1
AMpFESTR® Identifiler® 740 394344282 |26.926..|01 1.00 1.0 384 10.0 00 1
AMpFESTR@ MiniFiler™  |#6 6.53336906... |26.254...|01 0.50 1.0 129.7 10.0 0.0 1
AMpFESTR® MiniFiler™  |740 3.94344282... |26.926...|01 0.50 1.0 77.9 10.0 0.0 1
AMpFEISTR® Yfiler® #6 6.62583065... |27.185...|0.1 1.00 1.0 65.3 10.0 0.0 1

Export dilution and reaction worksheets

Export the STR Dilution Setup worksheet and the STR Reaction Setup worksheet as described in
“Export data” on page 60.

Save new STR kit information from an experiment into the
STR kit library

You can save a kit from an experiment into the library (for example, if you import an experiment from a
system with a different library setup).

Note: If the STR kit name that you are saving from the experiment is already listed in the library,
rename or delete the kit from the library before saving the kit information from the experiment.

1. Open the experiment.
2. In the STR Kit Setup screen, select the kit to save.

3. Click Save Kit to Library.
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Troubleshooting

Observation

Possible cause

Recommended action

File integrity warning

Details: HID Real-Time PCR
Analysis Software v1.4 may
display a file integrity warning
when opening an EDS file that
was analyzed in earlier versions
of the software.

There is a checksum
calculation modification in v1.4.

No action required. The file can be used with
no effect on the results obtained.

HID Real-Time PCR Analysis
Software v1.4 unexpectedly
closes when starting a 7500
instrument run

The instrument server
terminated and the server no
longer accepts commands.

Restart the 7500 instrument and the computer
that is running the HID Real-Time PCR
Analysis Software.

If the behavior continues, we recommend
that you disconnect the computer from the
network during runs on the 7500 instrument.

Note: We do not recommend using

HID Real-Time PCR Analysis Software v1.4
with the 7500 Real-Time PCR System for
Human Identification.
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Overview of the software validation for v1.3

70

HID Real-Time PCR Analysis Software v1.3 is designed for the Quantifiler™ DNA Quantification Kits and
the 7500 Real-Time PCR Instrument or the QuantStudio™ 5 Real-Time PCR Instrument with 0.2-mL
96-well sample block. The software enables streamlined quantification run setup, data analysis, and
STR reaction setup by providing Quantifiler™-specific templates and quality flags as well as STR sample
normalization (dilution) and reaction setup tools. HID Real-Time PCR Analysis Software v1.3 contains
the same functionality as the v1.2 software in addition to new features that support the use of virtual
standard curves and the use of the QuantStudio™ 5 Real-Time PCR System. For more information, see
“Features in v1.3” on page 71.

This appendix describes the results of experiments that Thermo Fisher Scientific performed to
validate HID Real-Time PCR Analysis Software v1.3. Data was collected using v1.2 and v1.3 of the
HID Real-Time PCR Analysis Software, the 7500 Real-Time PCR System and the QuantStudio™ 5
System, and the Quantifiler™ HP™, Trio, Duo, and Human DNA Quantification Kits.

The data collected from the 7500 and QuantStudio™ 5 instruments were analyzed to verify the following:

* HID Real-Time PCR Analysis Software v1.3 performs as designed to analyze data generated on the
7500 Real-Time PCR System and the QuantStudio™ 5 Real-Time PCR System.

* The new features do not adversely affect the quantification assays or the software functionality
carried over from the HID Real-Time PCR Analysis Software v1.2.

* When analyzed with HID Real-Time PCR Analysis Software v1.3, data generated using the 7500
Real-Time PCR System and the QuantStudio™ 5 Real-Time PCR System demonstrate reproducible
performance for the respective instrument models.

For validation experiments and results for the Quantifiler™ Trio, Duo, HP™, and Human kits, see the
Quantifiler™ HP and Quantifiler™ Trio DNA Quantification Kits User Guide (Pub. No. 4485354), the
Quantifiler™ Duo DNA Quantification Kit User Guide (Pub. No. 4391294), and the Quantifiler™ Human
DNA Quantification Kit and Y Human Male DNA Quantification Kit User Guide (Pub. No. 4344790 ).
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Appendix B HID Real-Time PCR Analysis Software v1.3 validation
Materials and methods

Features in v1.3

HID Real-Time PCR Analysis Software v1.3 includes all of the v1.2 functionality and includes the
following new features:

¢ Virtual Standard Curve support for Quantifiler™ HP™, Trio, Duo, and Human DNA Quantification
Kits.

® Support for the QuantStudio™ 5 Real-Time PCR Instrument with 0.2-mL 96-Well Sample Block.

Materials and methods

Instrument, computer, and software configuration
Instruments:
® 7500 Real-Time PCR System, firmware v2.10 (3)
* QuantStudio™ 5 Real-Time PCR System, 0.2-mL 96-well sample block (3)

Instrument 1 Instrument 2 Instrument 3 Instrliment Instrt;ment InstrLément

Model QuantStudio™ | QuantStudio™ | QuantStudio™ 7500 7500 7500
5 5 5
Computer Laptop Laptop Desktop Laptop Laptop Desktop
Microsoft™ OS Windows™ 7 Windows™ 7 Windows™ 7 | Windows™ 7 | Windows™ 7 | Windows™ 7
64-bit 64-bit 64-bit 64-bit 32-bit 32-bit

HID Real-Time PCR v1.3 v1.3 v1.3 v1.2 and vi.2 vi.2
Analysis Software v1.3

Chemistries and consumables

Unless otherwise indicated, all materials are available through thermofisher.com. Catalog numbers
that appear as links open the web pages for those products.

Item Cat. No.
Quantifiler™ Trio DNA Quantification Kit, 14 kits (from single lot) 4482910
Quantifiler™ HP DNA Quantification Kit, 5 kits (from single Iot) 4482911
Quantifiler™ Duo DNA Quantification Kit, 5 kits (from single lot) 4387746
Quantifiler™ Human DNA Quantification Kit, 5 kits (from single lot) 4343895
MicroAmp™ Optical 96-Well Reaction Plate, 10 plates N8010560
Modified TE Buffer (10/0.1) 300675
MicroAmp™ Optical Adhesive Film, 100 covers 4311971
7500 Real-Time PCR Systems Spectral Calibration Kit | 4349180
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Appendix B HID Real-Time PCR Analysis Software v1.3 validation
Materials and methods

(continued)

Item Cat. No.
ABY™ Spectral Calibration Plate, 96-Well 0.2-mL 4461591
JUN™ Spectral Calibration Plate, 96-Well 0.2-mL 4461593
TagMan™ RNase P Instrument Verification Plate for 7300/7500 Systems, 96-well 4350584
AmpF2STR™ DNA Control 007, Male N/A
AmpFLSTR™ Control DNA 9947A, Female N/A

The following test cases were performed for each chemistry kit:

Plates per instrument for the experiment
Quantifiler™ kit
Precision and linearity | Accuracy and reproducibility | Sensitivity | Mixture | Inhibition

Trio Kit 3 plates 1 plate 1 plate 1 plate | 1 plate
Duo Kit 3 plates 1 plate 1 plate 1 plate 1 plate
HP™ Kit 1 plate 1 plate - — —
Human Kit 1 plate 1 plate - - -
Samples

Experiment Sample Replicates per plate

Precision and
linearity

Quantifiler™ Trio, Duo, HP™, and Human Kit DNA Standards

6 standard curve

12 dilution series

Accuracy and
reproducibility

One male DNA, 1 ng/uL

96 replicates

Sensitivity

* Quantifiler™ Trio Kit—One male and one female DNA diluted to
100, 10, 1, 0.1, 0.01, 0.001, and 0.0001 ng/pL

* Quantifiler” Duo Kit—One male DNA diluted to 50, 5, 0.5, 0.05,
and 0.005 ng/pL

5 dilution series

5 dilution series

Mixture analysis

* Quantifiler™ Trio Kit—One set of male/female DNA mixture at 1:0,
1:1, 1:10, 1:100, 1:1000, 1:4000, 0:1 ratios

* Quantifiler™ Duo Kit—One set of male/female DNA mixture at 1:0,
1:1, 1:10, 1:100, 1:500, 1:1000, 0:1 ratios

3 mixture series

3 mixture series

Inhibition ® Quantifiler™ Trio Kit—One male 007 DNA (0.1 ng/pL) with hematin 96 replicates
(550 pm) 96 replicates
* Quantifiler™ Duo Kit—One male 007 DNA (0.1 ng/pL) with hematin
(80 pM)
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Appendix B HID Real-Time PCR Analysis Software v1.3 validation
Experiments and results

Data collection and analysis

* Run Method and analysis settings were configured as outlined in the respective Quantifiler™ kit user
manuals. The design and execution of all workflows (including instrument calibration, run setup,
data analysis, run methods, HID quality flags, dilution calculations import/export and reporting)
were identical for both versions of the software.

Note: The 7500 Systems were calibrated as explained in the Applied Biosystems™ 7500/7500 Fast
Real-Time PCR System: Maintenance Guide (Pub. No. 4387777).

Note: The QuantStudio™ 5 Systems were calibrated as explained in the QuantStudio™ 3 and
5 Real-Time PCR Systems Installation, Use, and Maintenance Guide (Pub. No. MANQ0010407).
The instruments were calibrated for the ABY™-HID and JUN™-HID dyes using the ABY™ Dye
Spectral Calibration Plate (Cat. No. 4461591) and the JUN™ Dye Spectral Calibration Plate
(Cat. No. 4461593).

® Calibration and experiment (EDS) data files that were previously generated using
HID Real-Time PCR Analysis Software v1.2 were imported and reanalyzed using
HID Real-Time PCR Analysis Software v1.3. The results from v1.2 and v1.3 were then compared for
differences in data output.

Experiments and results

Instrument performance

Test Case Description Passing Criteria Results
Precision and | Using each instrument, set up and run: For each system (7500 or Pass
linearity * Three plates of the standard curve QuantStudio™ 5):

dilution series using the Quantifiler™ Trio ¢ When running standard
and Duo Kits, standard curve dilution curves using the Quantifiler™
series. Trio, HP™, DUO, and Human
* One plate using the Quantifiler™ HP™ Assays, the Cr values
and Human Kits, standard curve dilution shall have a coefficient of
series. variation (CV) <20% within an
instrument.
Proc.iuc.e a stgndard curve from each pair * When running standard
of dilution series, so that six curves are . P
ted - hinst t curves using the Quantifiler
gengrg ed per plate on each ins ruzmen . Trio, HP™, DUO, and Human
Statistically evaluate the Ct and R< values for
L . . Assays, the system shall
variation within an instrument. 2
have a standard curve R
value =0.98.
Accuracy and | Using each instrument, set up and run one When running the Quantifiler™ Pass
reproducibility | plate of 007 DNA with 1 ng/uL input using Trio, HP™, DUO, and Human
each Quantifiler™ kit, 96 replicates per plate. | Assays, the within-instrument C+
Statistically evaluate the Ct values and DNA | and quantity values shall have a
quantity for variation within an instrument. CV =20% within an instrument.
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Appendix B HID Real-Time PCR Analysis Software v1.3 validation
Experiments and results

(continued)

Test Case Description Passing Criteria Results
Sensitivity Using each instrument, set up and run: When running Quantifiler™ Trio Pass
e One plate containing seven dilutions of | ASSays using O"O" ng/uL to

007 and 9947a DNA (from 0.0001 ng/uL | 10 n9/bL DNA input and when
to 100 ng/pL) prepared using the running Quantifiler™ Duo Assays
Quantifiler™ Trio Kit. using 0.05 ng/pL to 5 ng/puL DNA
. L o input, the in-plate Ct and quantity
One plate containing five dilutions of 007 values shall have a CV <20%
DNA (from O..OO5 ng/uL to. 50 ng/ulL) . within an instrument.
prepared using the Quantifiler™ Duo Kit.
Run five dilution series per sample per plate,
providing a total of five replicates for each
sample dilution. Statistically evaluate the Ct
values and DNA quantity data for variation
within an instrument.
Mixture Using each instrument, set up and run: When running Quantifiler™ Trio Pass
analysis e One set of male and female DNA mixture | 2nd DUO Assays usir?g mix.tures
samples consisting of seven mixture where the male DNA input is
ratios (1:0, 1:1, 1:10, 1:100, 1:1000, 0.02 ng/lL and the female
1:4000, and 0:1) using the Quantifiler™ DNA input is between 0.02 and
Trio Kit. 20 ng/pL, the Ct and quantity
. 0 — ; e DNA mi values shall have a CV <20%
ne set o .ma e and gma e ) mnfture within an instrument when results
samples with seven mixture ratios (1:0, are within range on the standard
1:1, 1:10, 1:100, 1:500, 1:1000, and 0:1) curve
using the Quantifiler™ Duo Kit. '
Run three replicates for each mixture sample.
Statistically evaluate the Ct values and
DNA quantity data for variation within an
instrument.
Inhibition Using each instrument, set up and run: When running Quantifiler™ Trio Pass
* One plate of 0.1 ng/pL 007 DNA with and DUO Assays, the generated Exception

550 uyM hematin using the Quantifiler™
Trio Kit.

* One plate of 0.1 ng/pL 007 DNA with
80 uM hematin using the Quantifiler™ Duo
Kit.

Run 96 replicates per plate. Statistically
evaluate the Cy values and quantity data for
variation within an instrument.

Ct and quantity values shall have
a CV <20% within an instrument.

conditions!1:2]

[ When tested using the Quantifiler™ DUO Kit and the QuantStudio™ 5 Instrument, samples with extreme hematin concentrations (>40 uM) can

produce a biphasic curve that may result in overestimation of DNA concentrations or quantity value CV significantly >20%.

[l At extreme hematin concentrations (~550 uM), more variation (quantity value CV significantly >20%) may be observed in the large autosomal
and Y targets on both 7500 and QuantStudio™ 5 Systems.
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Appendix B HID Real-Time PCR Analysis Software v1.3 validation
Experiments and results

Software performance

Test case Description Passing criteria Results
Custom Using one 7500 System and one The software shall successfully Pass
standard curve | QuantStudio™ 5 System, set up a virtual collect the data and automatically

standard curve using estimated slope and | apply the virtual standard curve.
y-intercept values. Perform a Quantifiler™ | The generated DNA quantities shall
Trio Kit run without standard curve be 100% concordant with the
samples. manual calculation.
Using three 7500 Systems and three For each respective system (7500 Pass
QuantStudio™ 5 Systems, evaluate the or QuantStudio™ 5), analyzing
virtual standard curve function using the the same experiment using the
sensitivity of a collected run. Create a actual and virtual standard curves,
virtual standard curve using the parameters | the software shall calculate
(slope and y-intercept) of the standard quantification values that match to
curve generated from the run. Analyze the | the third decimal point.
data using the actual standard curve and
the virtual standard curve, then compare
the DNA quantity values.
Workflow and Using one 7500 System computer and one | When comparing the v1.2 and Pass
user interface QuantStudio™ 5 System computer, confirm | v1.3 software, all values for the
that the settings match for all run/analysis | run/analysis methods and flag
methods and flag thresholds. thresholds shall be same.
Using 7500 and QuantStudio™ 5 Systems, | The software functions necessary Pass
run Quantifiler™ Trio and HP™ assays by for using the Quantifiler™ assays
following the standard workflow and using | shall perform without error.
the necessary software functions.
Backward Use the v1.3 software to reanalyze an When analyzing the EDS file using Pass
compatibility experiment (EDS) file generated using the v1.2 and v1.3 software, the
a 7500 System and the v1.2 software, calculated quantification values
then compare the quantification values shall match to the third decimal
calculated by both versions of the point.
software.
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Conclusions

Conclusions

76

Based on the validation of HID Real-Time PCR Analysis Software v1.3 and the precision and

linearity, accuracy and reproducibility, sensitivity, mixture analysis, and inhibition validation experiments
performed using the Quantifiler™ Trio, Duo, HP™, and Human Kits [see the Quantifiler™ HP and
Quantifiler™ Trio DNA Quantification Kits User Guide (Pub. No. 4485354), Quantifiler™ Duo DNA
Quantification Kit User Guide (Pub. No. 4391294), and Quantifiler™ Human DNA Quantification Kit and Y
Human Male DNA Quantification Kit User Guide (Pub. No. 4344790 )]:

All updates to v1.3 were successfully and correctly implemented without negative effects on
functionality carried over to v1.3 from v1.2.

HID Real-Time PCR Analysis Software v1.3 successfully controlled the 7500 Real-Time PCR
Systems and QuantStudio™ 5 Real-Time PCR Systems, and reliably and reproducibly set up and
collected quantification data using the Quantifiler™ kits.

The software provided accurate results when used to process Quantifiler™ kits for the analysis of
genomic DNA samples.

The user interface and HID workflows in v1.3 software performed as expected for both instruments
when using the Windows™ 7 operating systems.

The coefficient of variation (CV) for the average values of DNA quantity data and standard curve
parameters (Ct and R? values) where tested varied <20% within each instrument (7500 and
QuantStudio™ 5 Systems) using HID Real-Time PCR Analysis Software v1.2 and v1.3.

Laboratories should determine the appropriate level of testing required before implementation, based
on the nature of the changes made to the software, how the software pertains to their laboratory
workflow, their internal software validation guidelines, and those of the appropriate governing agencies.
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Obijective of the software verification for v1.4

The objective of this verification is to confirm that the software modifications made in

HID Real-Time PCR Analysis Software v1.4 function as expected when using the 7500 Real-Time PCR
System for Human Identification, the QuantStudio™ 5 Real-Time PCR System running firmware v1.5.1,
and the Quantifiler™ Trio, Duo, HP™, and Human Kkits.

Testing was performed according to Quality Assurance Standards (QAS) for Forensic DNA Testing
Laboratories (July 1, 2020), standard 8.8.3.4. Functional, regression, and reliability testing was
performed.
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Appendix C HID Real-Time PCR Analysis Software v1.4 verification

Functional testing

Functional testing

Functional tests were conducted to demonstrate that the software changes made in
HID Real-Time PCR Analysis Software v1.4 do not affect performance when using the Quantifiler™
kits with the 7500 Real-Time PCR System and the QuantStudio™ 5 Real-Time PCR System.

Note: HID Real-Time PCR Analysis Software v1.4 may unexpectedly close when starting a 7500
instrument run. Therefore, we do not recommend using v1.4 with the 7500 instrument.

Materials and methods

Instrument, computer, and software configuration

Instruments:

® 7500 Real-Time PCR System for Human Identification (2)
* QuantStudio™ 5 Real-Time PCR System, 0.2-mL 96-well sample block (3)

Instrument 1 Instrument 2 Instrument 3 Instrument 4 | Instrument 5
Model QuantStudio™ 5 | QuantStudio™ 5 QuantStudio™ 5 7500 7500
Instrument firmware v1.5.1 v1.5.1 Upgraded from v1.3.3 v2.10 v2.10
version tov1.5.1
Computer Dell™ Precision 3551
Image LTSC 2021 LTSC 2019 LTSC 2019 LTSC 2021 | LTSC 2019

Microsoft™ Windows™
0S

Windows™ 10, 64-bit operating system (IOT Enterprise)

HID Real-Time PCR
Analysis Software

vi4

Chemistries and consumables

Unless otherwise indicated, all materials are available through thermofisher.com. Catalog numbers
that appear as links open the web pages for those products.

ltem Cat. No.
Quantifiler™ Trio DNA Quantification Kit, 1 kit 4482910
Quantifiler™ HP DNA Quantification Kit, 1 kit 4482911
Quantifiler™ Duo DNA Quantification Kit, 1 kit 4387746
Quantifiler™ Human DNA Quantification Kit, 1 kit 4343895
MicroAmp™ Optical 96-Well Reaction Plate with Barcode, 20 plates 4306737
MicroAmp™ Optical Adhesive Film, 100 covers 4311971
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Appendix C HID Real-Time PCR Analysis Software v1.4 verification

Regression testing

(continued)

Item Cat. No.
ABY™ Spectral Calibration Plate, 96-Well 0.2-mL 4461591
JUN™ Spectral Calibration Plate, 96-Well 0.2-mL 4461593
TagMan™ RNase P Instrument Verification Plate, 96-Well 0.2-mL 4432382

AmpF2STR™ DNA Control 007, Male

4460779, 4478871

Teknova™ DNA Suspension Buffer, pH 8.0

T0227

Data collection and analysis

¢ Data was collected using HID Real-Time PCR Analysis Software v1.4, the 7500 Real-Time PCR
System and the QuantStudio™ 5 Real-Time PCR System (firmware v1.5.1), and the Quantifiler™ Trio,
Duo, HP™, and Human DNA Quantification Kits.

* Run Method and analysis settings were configured as outlined in the respective Quantifiler™ kit user

manuals.
Results
Test case Samples Passing criteria Result
Linearity Quantifiler™ Trio, Duo, HP™, and Evaluate the R? and slope values for each Pass

Human Kit DNA standards:

® 4 standard curve dilution series
for each Quantifiler™ kit

standard curve:

¢ R2value =0.985 for the Trio, HP™ and Duo
kits; =0.980 for the Human kit

* The slope values for each target
are within the range observed during
the developmental validation of each
Quantifiler™ kit.

Accuracy and
reproducibility

DNA Control 007, 1 ng:

* 4 replicates for each
Quantifiler™ kit

The 1 ng/pL 007 DNA concentration is within Pass

range 0.60-1.65 ng/uL

Contamination

DNA Dilution Buffer:

* 4 replicates for each
Quantifiler™ kit

An undetermined (UND) result Pass

Regression testing

Regression testing was performed to confirm that the software changes made in HID Real-Time PCR

Analysis Software v1.4 do not impact the overall software functionality. The test cases performed were

designed to ensure that the features and functionalities of HID Real-Time PCR Analysis Software v1.4

work the same as in v1.3.x.
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Appendix C HID Real-Time PCR Analysis Software v1.4 verification
Regression testing

Materials

Instrument, computer, and software configuration

Instruments:
® 7500 Real-Time PCR System for Human Identification (1)
* QuantStudio™ 5 Real-Time PCR System, 0.2-mL 96-well sample block (2)

Instrument 1

Instrument 2

Instrument 3

Model

QuantStudio™ 5

QuantStudio™ 5

7500

Instrument firmware version

v1.5.1

Upgraded from v1.3.3 to v1.5.1

v2.10

Computer!!!

Dell™ Precision 3551 and 3571

Imagel?

LTSC 2019 and 2021

Microsoft™ Windows™ OS

Windows™ 10, 64-bit operating system (IOT Enterprise)

HID Real-Time PCR Analysis Software

vi.3.2and vi.4

01" All configurations were tested across each instrument.
2l All configurations were tested across each instrument.

Results
Test case Description Passing criteria Result

Workflow and Confirm that the settings match for all When comparing HID Real-Time PCR Pass

user interface run/analysis methods and flag thresholds for | Analysis Software v1.3.2 and v1.4, all
each Quantifiler™ kit. values for the run/analysis methods and

flag thresholds shall be same.

Run each Quantifiler™ assay by following the | The software features and functions Pass
standard workflow and using the necessary shall perform without error for each of
software functions. the Quantifiler™ kits tested.

Virtual standard | Create a virtual standard curve using The software shall successfully collect Pass

curve estimated slope and y-intercept values. the data and automatically apply the
Execute a run for each Quantifiler™ kit without | virtual standard curve.
adding standards to the experiment.

Backward Use HID Real-Time PCR Analysis Software The calculated quantification values in Pass

compatibility v1.4 to reanalyze an experiment (EDS) file HID Real-Time PCR Analysis Software
generated using a 7500 and a QuantStudio™ 5 | v1.4 should be concordant to those
System with HID Real-Time PCR Analysis obtained in v1.3.2.
Software v1.3.2. Compare the quantification
values calculated by both versions of the
software.
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Appendix C HID Real-Time PCR Analysis Software v1.4 verification
Reliability testing

Reliability testing

Reliability testing was performed to evaluate the software performance within and beyond functional
aspects. A variety of user scenarios were tested as presented in Table 6. Functional and non-functional
tasks from instrument sign-in through uninstallation of the software performed as expected.

Table 6 Test cases used to evaluate the reliability of HID Real-Time PCR Analysis Software v1.4 with the
7500 and QuantStudio™ 5 Systems

Performed as

(One 7500 System and
two QuantStudio™ 5
Systems)

did not affect functionality:
* Import a plate setup
* Open files using File » Open, or clicking the EDS or EDT file name

* Save the EDS files after run completion (7500 and QuantStudio™ 5
Systems)

* Export data to a CSV file
* Export reports to a PDF file

Category Test Expected
(Y/N)

Install/uninstall The user can install HID Real-Time PCR Analysis Software v1.4 using Y
a new or an upgrade registration code. The user is able to uninstall
HID Real-Time PCR Analysis Software v1.4.

Instrument Connection of the Dell™ Precision 3551 and 3571 laptops running Y

connectivity HID Real-Time PCR Analysis Software v1.4 to one 7500 System and two
QuantStudio™ 5 Systems (firmware v1.5.1).

Calibrations 7500 System calibrations migrated from the Dell™ Precision 3551 to the Y
3571.

User profiles The user can create a new profile within HID Real-Time PCR Analysis Y
Software v1.4, then sign in to the software with this new user profile.

Functional testing The following functions were evaluated to ensure that software changes Y

Conclusions

Based on this verification, we can conclude that all updates to HID Real-Time PCR Analysis Software
v1.4 did not affect performance when using the Quantifiler™ kits and the 7500 Real-Time PCR System
and QuantStudio™ 5 Real-Time PCR System (firmware v1.5.1). This version of software maintains the
functionality and reliability of previous versions.
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Configure STR library and default
dilution settings

Configure the STR Kit Library
Set default dilution settings

Configure the STR Kit Library

Most AmpF2STR™ kits are listed in the STR Kit Library by default. To add or modify amplification kit
information, perform the following steps.

1. In the toolbar, select Tools » AmpFESTR™ Kit Library to open the Kit Dilutions Library screen.

2. Add, edit, and/or delete a kit.

Add a kit—Click New. The Create New STR Kit dialog box opens.

Edit a kit— Select the kit, then click Edit. The Create New STR Kit dialog box opens.
* Delete a kit—Select the kit, then click Delete.

% AmpFtSTR kit Library x|

a Add new kits, edit existing kits, delete kits, impart kits, or export kits. Apply a filter Q)
to reduce the number of kits displayed.

Enter a filter guery, then click "Apply Filter." To enter multiple filter que... \ Advanced Fiter 1

IF [Kit Mame j |= LI I Apply Fiter ‘ ‘ Remove Filter |

Mew ... | Edit.. | Delete | Delete All
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Appendix D Configure STR library and default dilution settings
Configure the STR Kit Library

3. If you add or edit a kit, enter settings as needed.
¢ STR Kit Name—The name of the kit that you are adding to the list.

Note: Kit names must be unique. To use the same kit with different sample types or different
input amounts of DNA, add the kit with a different name, such as Identifiler™_1.5 ng.

* Target Conc.—The amount of DNA that you want to use divided by the total sample volume
per reaction. Examples:

Total DNA (ng) Volume/reaction (uL) Target concentration (ng/pL)
0.5 10 0.05
1.0 10 0.1
1.0 20 0.05
2.0 20 0.1

* STR Reaction pane
— PCR Master Mix—Enter appropriate volumes (uL).
— Sample—Enter appropriate volumes (uL).
The volumes of master mix and sample must equal the total volume of the STR reaction:

Sample (pL) + PCR master mix (pL) = Reaction volume (upL)

— Additional # of Reactions and/or Amplification Controls —Enter the number of
additional STR reactions per amplifications to allow for pipetting overage.

IMPORTANT! Because not all kits allow for pipetting overage, you may need to enter
more additional reactions to compensate for volume losses that occur during pipetting.
For information about pipetting overage, see the user guide for your kit.

* PCR Master Mix pane—List each component of the STR reaction master mix. For more
information, see the user guide for your kit.

B create New STR Kit x|

Enter all the information for the new STR Kit, then click OK to save. *= Require d-‘

STR Kit Mame ISTR Kit 1
Target Conc. (ngipl) 0.1

STR Reaction

PCR Master Mix ID.U pMUreaction
Sample ID.U pUreaction

Additional # of reactions and/or Amplification Controls I‘I

PCR Master Mix
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Appendix D Configure STR library and default dilution settings
Set default dilution settings

4. Click OK.
5. Repeat steps 2 on page 82 through 4 on page 84 for all needed kits.

6. Verify that the kits to be used in the downstream STR reactions are listed, with correct information.

Note: You can also save a kit from an experiment into the library (for example, if you import an
experiment from a system with a different library setup). See “Save new STR kit information from
an experiment into the STR kit library” on page 68.

Set default dilution settings

In the Analysis Settings screen, you can specify default dilution settings to apply to all samples. (You
can edit individual sample dilution settings after you associate an STR kit with an experiment.)

1. In the Experiment Menu, select any analysis screen, then click Analysis Settings.
2. Select the HID Settings tab.

3. In the Dilution Scheme pane, enter dilution scheme parameters according to your preferences or
laboratory protocol.

* Pipetting overage—The percent to add to compensate for error in pipetting. If the sample
concentration is less than the target concentration and the sample volume is limited, set the
pipetting overage to zero to maximize the amount of DNA in the STR reaction.

*  Minimum Pipetting Volume —The minimum volume that you want to pipette.
¢ Maximum Sample Volume—The maximum quantity of sample that you want to use.

¢ Dilution Factor—The maximum first dilution that you want to perform with the available DNA.
For example, for 10-fold first dilutions, enter 10.

4. In the Dilution Method pane, select one of the following methods.
* One Step Dilution Only—To use a single dilution in all instances.
* System Select—To use a dilution scheme that depends on your preferences, with a maximum
of two dilutions.

The software displays the target sample concentration based on the maximum sample volume,
number of replicates, sample volume per STR reaction, and pipetting overage that you set if the
desired target concentration cannot be reached.
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Appendix D Configure STR library and default dilution settings
Set default dilution settings

& Analysis Settings for Untitled

HID SeﬂingsT Ct Settings T Flag Settings }

Dilution Scheme - Dilution Method Display M:F Ratio
Pipetting Overage % (® One Step Dilution Only Display the Male
to Female Ratio
s e (1:X) ifthe female
Minimum Pipetting Volume L O system Select i

ratio () is greater

Maximum Sample Volume WL 1 lowed D nf :| than or equal to
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Documentation and support

Related documentation

Table 7 Documents for HID Real-Time PCR Analysis Software experiments

Document Pub. No.
Quantifiler™ HP and Quantifiler™ Trio DNA Quantification Kits User Guide 4485354
Quantifiler™ Duo DNA Quantification Kit User Guide 4391294
Quantifiler™ Human DNA Quantification Kit and Y Human Male DNA Quantification Kit User Guide 4344790
Applied Biosystems™ 7500/7500 Fast Real-Time PCR System Maintenance Guide 4412844
7500/7500 Fast Real-Time PCR System Getting Started Guide for Absolute Quantification 4378658
Experiments
Applied Biosystems™ 7500/7500 Fast Real-Time PCR System Getting Started Guide: Standard 4387779
Curve Experiments
QuantStudio™ 3 and 5 Real-Time PCR Systems Installation, Use, and Maintenance Guide MANO0010407
QuantStudio™ Design and Analysis Desktop Software User Guide MANO0O010408

Table 8 Documents for custom experiments

See the following documents for information on performing custom experiments instead of using the HID Real-Time PCR Analysis
Software.

Document Pub. No.

Applied Biosystems™ 7500/7500 Fast Real-Time PCR System Getting Started Guide: Genotyping 4387784
Experiments

Applied Biosystems™ 7500/7500 Fast Real-Time PCR System Getting Started Guide: Presence/ Absence | 4387785
Experiments

Applied Biosystems™ 7500/7500 Fast Real-Time PCR System Getting Started Guide: Relative Standard | 4387783
Curve and Comparative C; Experiments

Applied Biosystems™ 7500/7500 Fast Real-Time PCR System Getting Started Guide: Standard Curve 4387779
Experiments

7500/7500 Fast Real-Time PCR System Getting Started Guide for Absolute Quantification Experiments 4378658
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Appendix E Documentation and support
Customer and technical support

Customer and technical support

For support:

* In North America—Send an email to HIDTechSupport@thermofisher.com, or call
888-821-4443 option 1.

* Outside North America— Contact your local support office.

For the latest services and support information for all locations, go to thermofisher.com/support to
obtain the following information.

Worldwide contact telephone numbers

* Product support

* Order and web support

* Safety Data Sheets (SDSs; also known as MSDSs)

Additional product documentation, including user guides and Certificates of Analysis, are available by
contacting Customer Support.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.

HID Real-Time PCR Analysis Software User Guide

87


mailto://mailto:HIDTechSupport@thermofisher.com
http://thermofisher.com/support
http://www.thermofisher.com/us/en/home/global/terms-and-conditions.html
http://www.thermofisher.com/us/en/home/global/terms-and-conditions.html
http://www.thermofisher.com/support

thermofisher.com/support | thermofisher.com/askaquestion Thermo Fisher
thermofisher.com SCIENTIFIC

7 February 2024


http://thermofisher.com/support
http://thermofisher.com/askaquestion
http://thermofisher.com

	HID Real‑Time PCR Analysis Software User Guide (Pub. No. MAN0009819 G.0)
	Copyright Page
	Contents
	Chapter 1. Product information
	Product description
	New features in v1.4
	Compatible systems
	Compatible HID kits
	Custom experiment option
	HID Real‑Time PCR Analysis Software workflow

	Chapter 2. Install the HID Real‑Time PCR Analysis Software and calibrate the instruments
	Computer and instrument requirements
	7500 Real-Time PCR Systems purchased before February 2008

	Install the HID Real‑Time PCR Analysis Software
	Calibrate the 7500 instrument
	Required materials not supplied
	Calibration procedures
	New dye spectra for the 7500 Real‑Time PCR Instrument

	Calibrate the QuantStudio™ 5 Instrument
	Required materials not supplied
	Calibration procedures
	New dye spectra for the QuantStudio™ 5 Real-Time PCR Instrument


	Chapter 3. Customize the software
	Modify a default experiment template
	Save a copy of the original template
	Modify the original template

	Create an experiment template
	Link your template to a Home screen button
	Set display defaults
	Select data to display in the plate view
	Specify the data to display in the well table
	Customize the amplification plot


	Chapter 4. Select the experiment and set up a plate
	Start the software and select an experiment
	For custom experiments

	Navigate the software
	Specify experiment properties
	Define samples and view targets
	Define samples
	View targets
	Change a color designation

	Assign the targets, samples, and standards to wells
	Open the Assign Targets and Samples tab
	Assign using the plate layout
	Assign samples, standards, and NTCs to wells
	Assign a new sample to a well
	Move samples, standards, and NTCs

	Assign using the well table

	Save the plate layout as EDS or template
	Link your template to a Home screen button

	Chapter 5. Run the plate
	View the run method
	(7500 system only) Set notifications
	Start or stop the run
	Start a run
	Stop a run

	(7500 system only) Monitor a run
	Save the results

	Chapter 6. Select analysis settings and thresholds
	Open analysis settings
	View and edit CT settings
	Enter HID settings
	HIGHQT
	IPCCT
	LOWQT
	NTCCT
	MTFR flag and M:F ratio display
	SLOPE
	R2
	YINT

	Enter flag settings
	Add a virtual standard curve to the experiment
	Guidelines for using virtual standard curves
	Create a virtual standard curve
	Apply a virtual standard curve to an experiment
	Before you apply the curve
	Apply a standard curve
	Automatic analysis using a default virtual standard curve



	Chapter 7. Enhance data analysis
	View the analysis results
	Flagged wells
	Standard Curve bar
	Standard bar
	NTC bar
	Unknown bar
	Instrument-related flags

	Wells automatically omitted

	Interpret QC flag information
	Omit wells from analysis
	Omit targets in an experiment well
	Examine the Degradation Index
	Change the appearance of, print, and save plots
	Change the appearance of a plot
	Select the wells to include in the report
	Print or save a plot


	Chapter 8. Export and report results
	Export data
	Print a report

	Chapter 9. Generate dilution and reaction worksheets for STR setup
	Add kits to an experiment
	Select unknown samples for amplification
	Edit dilution settings for individual samples
	View the dilution scheme
	Export dilution and reaction worksheets
	Save new STR kit information from an experiment into the STR kit library

	Appendix A. Troubleshooting
	File integrity warning
	HID Real‑Time PCR Analysis Software v1.4 unexpectedly closes when starting a 7500 instrument run

	Appendix B. HID Real‑Time PCR Analysis Software v1.3 validation
	Overview of the software validation for v1.3
	Features in v1.3

	Materials and methods
	Experiments and results
	Instrument performance
	Software performance

	Conclusions

	Appendix C. HID Real‑Time PCR Analysis Software v1.4 verification
	Objective of the software verification for v1.4
	Functional testing
	Materials and methods
	Results

	Regression testing
	Materials
	Results

	Reliability testing
	Conclusions

	Appendix D. Configure STR library and default dilution settings
	Configure the STR Kit Library
	Set default dilution settings

	Appendix E. Documentation and support
	Related documentation
	Customer and technical support
	Limited product warranty

	Back Cover


